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Printer Parts and Control Panel Functions

 

paper support 
adapter

edge guides

paper support extension

output tray

paper support
printer cover

sheet feeder

output tray 
extension

roll paper holder

USB interface cable 
connector

parallel interface cable 
connector
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Buttons

Button Function

P

power

Turns the printer on and off.

Clears the printer’s memory if pressed twice while the power 
is on.

b
maintenance

Loads or ejects paper if pressed and released within 
two seconds.

Resumes printing if pressed and released after a paper out 
error.

Performs print head cleaning if pressed for 3 seconds when 
the b error light is off.

Moves the print head to the ink cartridge replacement position 
and charges ink to the printer when ink is out.

z
roll paper

Loads and ejects roll paper.

Feeds roll paper in reverse to a position where it can be easily 
removed from the sheet feeder, if pressed for more than 3 
seconds.

Clears the b error light if pressed after removing roll paper.

ink cartridge clamps

print head

control panel

adjust lever

ink cartridge 
replacement button
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Lights

e
ink cartridge 
replacement

Moves the print head to the ink cartridge replacement position 
and charges ink to the printer when ink is out (this orange 
button is located under the printer cover, not in the control 
panel).

Light Description

P

power

On when the printer is on.

Flashing when printer is receiving data, printing, replacing an 
ink cartridge, charging ink, or cleaning the print head.

b

error

On when the printer is out of paper. Load paper in the sheet 
feeder, then press the b maintenance button to resume 
printing.

On when the paper is jammed. Take all of the paper out of 
the feeder, then reload the paper. If the light continues to 
flash, turn off the printer and gently pull all of the paper out of 
the printer.

Flashing when the black or color ink cartridge is nearly empty.

On when the black or color ink cartridge is empty. Replace 
the black ink cartridge or color ink cartridge.

Black:
T007 Standard Capacity
T010 Light Capacity
Color:
T009 (Stylus Photo 1290)
T008 (Stylus Photo 890)

Flashing when the print head moves to the ink cartridge 
replacement position. The light will flash faster if the color ink 
is out than if the black ink is out.
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Safety Instructions

Important Safety Instructions

Read all of the instructions in this section before using your 
printer. Also, be sure to follow all warnings and instructions 
marked on the printer.

When setting up your printer

Observe the following when setting up the printer:

❏ Do not block or cover the openings in the printer’s cabinet.

❏ Use only the type of power source indicated on the printer’s 
label.

❏ Connect all equipment to properly grounded power outlets. 
Avoid using outlets on the same circuit as photocopiers or air 
control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or 
automatic timers.

❏ Keep the entire computer system away from potential sources 
of electromagnetic interference, such as loudspeakers or the 
base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.

❏ If you use an extension cord with the printer, make sure that 
the total ampere rating of the devices plugged into the 
extension cord does not exceed the cord’s ampere rating. Also, 
make sure that the total ampere rating of all devices plugged 
into the wall outlet does not exceed the wall outlet’s ampere 
rating.
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❏ Do not attempt to service the printer yourself.

❏ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the 
printer; the printer has been dropped or the cabinet damaged; 
the printer does not operate normally or exhibits a distinct 
change in performance.

❏ If you plan to use the printer in Germany, the building 
installation must be protected by a 10 or 16 amp circuit 
breaker to provide adequate short-circuit protection and 
over-current protection for this printer.

When choosing a place for the printer

Observe the following when choosing a place for the printer:

❏ Place the printer on a flat, stable surface that extends beyond 
the printer base in all directions. The printer will not operate 
properly if it is tilted or at an angle.

❏ Leave enough space in front of the printer for the paper to be 
fully ejected.

❏ Avoid places subject to rapid changes in temperature and 
humidity. Also, keep the printer away from direct sunlight, 
strong light, or heat sources.

❏ Avoid places subject to dust, shocks, and vibrations.

❏ Leave enough room around the printer to allow for sufficient 
ventilation.

❏ Place the printer near a wall outlet where the plug can be 
easily unplugged.
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When using the printer

Observe the following when using the printer:

❏ Do not insert objects through the slots in the printer’s cabinet.

❏ Take care not to spill liquid on the printer.

❏ Do not put your hand inside the printer or touch the ink 
cartridges during printing.

❏ Do not move the print head by hand; otherwise, you may 
damage the printer.

❏ Always turn the printer off using the P power button. When 
this button is pressed, the P power light flashes briefly and 
then goes out. Do not unplug the printer or turn off the power 
to the outlet until the P power light stops flashing.

❏ Before transporting the printer, make sure that the print head 
is in the home (far right) position and the ink cartridges are 
in place.

When handling the ink cartridges

Observe the following when handling the ink cartridges:

❏ Keep ink cartridges out of the reach of children. Do not allow 
children to drink from or otherwise handle the cartridges.

❏ Be careful when you handle the used ink cartridges, as there 
may be some ink remaining around the ink supply port. If ink 
gets on your skin, wash the area thoroughly with soap and 
water. If ink gets in your eyes, flush them immediately with 
water. If discomfort or vision problems remain after a 
thorough flushing, see a doctor immediately.

❏ Do not shake an ink cartridge; this can cause leakage.
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❏ Install the ink cartridge immediately after you remove it from 
its package. Leaving the cartridge unpacked for a long time 
before use may result in reduced print quality.

❏ Do not use an ink cartridge beyond the date printed on the 
cartridge carton. For best results, use up the ink cartridges 
within six months of installing them.

❏ Do not dismantle the ink cartridges or try to refill them. This 
could damage the print head.

❏ After bringing an ink cartridge inside from a cold storage site, 
allow it to warm up at room temperature for at least three 
hours before using it.

❏ Store ink cartridges in a cool, dark place.

❏ Do not touch the green IC chip on the side of the cartridge. 
This may affect normal operation and printing.

❏ The IC chip on this ink cartridge retains a variety of cartridge 
related-information, such as the amount of ink remaining, so 
that a cartridge may be removed and reinserted freely. 
However, each time the cartridge is inserted, some ink is 
consumed because the printer automatically performs a 
reliability check.

❏ If you remove an ink cartridge for later use, protect the ink 
supply area from dirt and dust and store it in the same 
environment as the printer. A valve in the ink supply port 
makes covers or plugs unnecessary, but the ink may stain 
items that come in contact with this area of the cartridge. Do 
not touch the ink supply port or surrounding area.
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ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined 
that this product meets the ENERGY STAR guidelines 
for energy efficiency.

The International ENERGY STAR Office Equipment Program is 
a voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient personal 
computers, monitors, printers, fax machines, copiers, and 
scanners in an effort to reduce air pollution caused by power 
generation.

Warnings, Cautions, and Notes

w
Warnings
must be followed carefully to avoid bodily injury.

c
Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of your 
printer.
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Chapter 1

Paper Handling

Loading Plain Paper

Follow the steps below to load plain paper in the printer.

1. Lower the output tray. Next, slide the left edge guide so that 
the distance between the edge guides is slightly wider than 
the width of your paper.

For Stylus Photo 1290 users, if you load long paper (for 
example, A3 size paper), pull up the paper support extension.

2. Fan a stack of paper, then tap it on a flat surface to even the 
edges.

3. Load the stack of paper in the sheet feeder with the printable 
side up and the right edge of the paper resting against the 
right edge guide. Then, slide the left edge guide against the 
left edge of the paper.
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Note:
❏ Leave enough space in front of the printer for the paper to be 

fully ejected.

❏ Always load paper into the sheet feeder short edge first.

❏ Make sure that the paper stack fits under the arrow mark inside 
the edge guide.

Loading Special Paper and Other Media

You can achieve good results with most types of plain bond paper. 
However, coated paper and glossy film result in higher quality 
printouts because these media absorb smaller amounts of ink.

EPSON provides special media that are formulated for the ink 
used in EPSON ink jet printers. EPSON recommends using media 
distributed by EPSON to ensure high-quality results. See “Media 
types” on page 11-2 for a complete list of these products.

When loading special media distributed by EPSON, read the 
instruction sheets packed with the media first and keep the 
following points in mind.

c
Caution:
Cleaning sheets packaged with EPSON special media should not 
be used with this printer. The cleaning function performed by 
these sheets is not necessary with this type of printer, and the 
sheets could jam in the printer.
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❏ Load the media printable side up in the sheet feeder. See the 
instruction sheets packed with the media to determine which 
side is the printable side. Some types of media have cut 
corners to help identify the correct loading direction, as 
shown in the illustration.

Note:
If you extend the printable area by selecting Maximum as the 
Printable Area setting in the printer software, the cut corner on 
special paper may mar your printout.

❏ Make sure that the paper stack fits under the arrow mark 
located on the inside surface of the left edge guide.

❏ If the paper is curled, flatten it or curl it slightly toward the 
opposite side before loading. Printing on curled paper may 
cause ink to smear on your printout, especially when printing 
with Maximum selected as the Printable Area setting.

printable
side up

cut corner
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❏ If you want to print on the reverse side of an Ink Jet Card with 
Maximum selected as the Printable Area setting, flatten the 
card or curl it slightly toward the opposite side before loading.

❏ If ink smears on your documents when printing on thick 
media, set the adjust lever to the “+” position. To change the 
setting, open the printer cover and position the lever as shown 
in the illustration.

Note:
❏ Return the adjust lever to the “0” position before printing on 

media of normal thickness. Leaving the lever in the “+” position 
may cause gaps in the printed image. 

❏ When the adjust lever is in the “+” position, make sure the High 
Speed setting in the printer driver’s Advanced dialog box is off. 
To turn this option off, you may also need to change the Print 
Quality setting or align the print head using the Print Head 
Alignment utility.

If you wish to print on the reverse side of an Ink Jet Card with 
Maximum selected as the Printable Area setting, flatten the 
cards or curl them slightly toward the opposite side before 
loading. Set the adjust lever to the “+” position before 
printing.
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Loading capacities for EPSON special media

Refer to the chart below to find the loading capacities for EPSON 
special media.

Media Type Loading Capacity

360 dpi Ink Jet Paper and Photo 
Quality Ink Jet Paper

Up to the arrow mark on the left edge 
guide.

Photo Quality Ink Jet Cards, Ink Jet 
Note Cards, and Ink Jet Greeting 
Cards

Up to 30 index cards.
Always place the included support 
sheet* under the cards.

Photo Quality Glossy Film One sheet at a time for best results. 
Always place a support sheet* or a 
sheet of plain paper under the glossy 
film.
If you wish to load multiple sheets, set 
the minimum top margin of the page 
to 30 mm and load a maximum of 
20 sheets for A4.
For A3 and Super A3 size, you can 
load up to 5 sheets at a time (only for 
Stylus Photo 1290).

Ink Jet Transparencies Up to 30 transparencies.
Always put a sheet of plain paper 
under the stack of transparencies.

Photo Quality Self Adhesive 
Sheets

One sheet at a time.

Photo Paper Up to 20 sheets of 4 × 6 inch Photo 
Paper. Always place a support sheet* 
under the stack of Photo Paper.
One sheet at a time for 200 × 300 mm 
Photo Paper.

Photo Stickers 16 and Photo 
Stickers 4

One sheet at a time.
Always put the included support 
sheets* A and B under the stack of 
Photo Stickers.

Panoramic Photo Paper and Iron-
On Cool Peel Transfer Paper

One sheet at a time.
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* Take care not to print on support sheets that are loaded under special media.

Storing EPSON Photo Paper

Return unused paper to the original package as soon as you finish 
printing. Also, EPSON recommends storing your printouts in a 
resealable plastic bag. Keep them away from high temperature, 
humidity, and direct sunlight.

Loading Envelopes

When printing on envelopes, please note the following:

❏ You can load up to 10 envelopes at a time in the sheet feeder.

Note:
The folding quality and thickness of envelopes vary widely. If the 
total thickness of the stack of envelopes exceeds 10 mm, press each 
envelope in the stack flat before loading. If print quality declines 
when a stack of envelopes is loaded, load one envelope at a time.

❏ Set the adjust lever to the “+” position. To do this, open the 
printer cover and reposition the lever.

Matte Paper-Heavyweight Up to 20 sheets. Always place a 
support sheet* under the stack of 
Matte Paper-Heavyweight.
For A3 and Super A3 size, you can 
only load one sheet at a time (only for 
Stylus Photo 1290).

Premium Glossy Photo Paper One sheet at a time.

Ink Jet Back Light Film
(only for Stylus Photo 1290)

One sheet at a time.
Always put a sheet of plain paper 
under back light film.
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Note:
❏ Return the adjust lever to the “0” position, which is the normal 

position, after you finish printing on envelopes. Leaving the 
lever in the “+” position may cause gaps to appear in images 
printed on other media.

❏ When the adjust lever is in the “+” position, make sure the High 
Speed setting in the printer driver’s Advanced dialog box is off. 
To turn this option off, you may also need to change the Print 
Quality setting.

❏ Load envelopes flap edge first with the flap side down, as 
shown in the illustration.

❏ Do not use envelopes that are curled or folded. 

❏ Flatten envelopes before loading. 

❏ Avoid using envelopes that are too thin as they may curl 
during printing.

❏ Select Plain Paper as the Media Type setting in the printer 
software.

Available envelopes sizes are:
No.10, DL, C6, 132 mm × 220 mm
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Chapter 2

Using Roll Paper

Using the Roll Paper Holder

With the Roll paper holder packed in the printer, you can print in 
roll paper format which is convenient for banner printing. When 
you are printing using the Roll paper holder, keep the following 
in mind.

❏ Load the paper printable side up.

❏ Use flat, undamaged paper. If the paper is curled, flatten it 
before loading to avoid paper feeding problems.

❏ Always handle the paper by the edges.

❏ Provide ample space in front of the printer for the paper to 
eject fully.

❏ Make sure that the output tray is down and the output tray 
extension is closed.

❏ Check that the end of the paper is cut cleanly, perpendicular 
to the long axis of the paper. If it is cut on a diagonal or not 
cleanly, the paper may not feed smoothly or the print may 
extend off the edge of the paper.

❏ EPSON recommends using media distributed by EPSON to 
ensure high-quality results.

Loading the Roll Paper

Follow the directions below to mount the Roll paper holder and 
load the roll paper.
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1. Set roll paper in the roll paper holder.

Note:
Remove the transparent sheet after setting the roll paper into the 
holders.

2. Check that the end of the roll is cut perpendicularly to the 
edges as shown. For A4 and 329-mm width paper, cut along 
one of the parallel lines on the back. For 89- and 100-mm width 
paper, use a triangle.

c
Caution:
Always use a triangle or other tool to ensure that the end of 
the roll is cut perpendicularly. A diagonal cut may cause 
paper feed problems.
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3. To uncurl the paper, roll the paper inside the protective film 
packaged with the printer in the direction opposite to the 
paper’s curl, as shown below.

4. Remove the paper support and lower the output tray. Then, 
turn on the printer.

5. Attach the roll paper holder to the printer by inserting it in 
the slots at the back of the printer.
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6. Gently insert the end of the paper into the printer as far as it 
will go, flush with the right edge guide. Slide the left edge 
guide against the left edge of the paper.

7. To load the paper correctly, you must hold the paper in place 
with your hand while you press the z roll paper button. The 
paper feeds into the printer.

8. Open the printer cover and make sure that the paper  is 
feeding correctly. If it is not straight, depress the z roll paper 
button for more than three seconds to eject the paper. The 
error light is on. Press the z roll paper button to clear the 
error, then feed the paper again.
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The roll paper is now loaded. Next, set up the printer software 
and try printing. For details on setting up the printer software, 
refer to “Printing on Roll Paper” on page 2-5.

Printing on Roll Paper

Once you have prepared your roll paper and it is loaded in the 
printer, you must make settings in the printer software in order 
to print.

Printing area and margins in Roll Paper

You can apply various settings for printing area and margins on 
roll paper with driver settings. There are two types of margin 
settings: Even if 3-mm of both side of paper or No Margins is 
selected, the top margin is automatically set to 20 mm.

Refer to the table below for the instructions.

3-mm of both side of paper

Select Roll Paper as the Paper Source in the printer 
driver.

When printing is finished, press the z roll paper button 
once to print a cutting guideline about 12mm from the 
bottom of the print data.

To print the next print job, press the z roll paper button 
to feed the paper back to the printing position, then 
apply printing. In this case, the space between the two 
blocks of print data will be 36mm.
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No Margins

For Windows users

Note:
❏ When printing on roll paper, you cannot use the Reverse Order 

or Rotate by 180°  features, select Maximum  or Centered  as the 
Printable Area setting, or use the functions on the Layout menu.

❏ Do not select PhotoEnhance  in the printer software, as this may 
cause offsets in the print area at logical page boundaries.

When printing data which spans multiple pages or 
when  printing data without pressing roll paper button 
after printing one block of data, the margin between 
data will be set to 0. 

Select Roll Paper as the Paper Source and check the 
No margins box in the printer driver.

When printing is finished, press the z roll paper button 
once to print a cutting guideline about 12mm from the 
bottom of the print data.

To print the next print job, press the z roll paper button 
to feed the paper back to the printing position, then 
apply printing. In this case, the space between the two 
blocks of print data will be 36mm.

When printing data which spans multiple pages or 
when  printing data without pressing roll paper button 
after printing one block of data, the margin between 
data will be set to 0. 
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After the roll paper is loaded in the printer, follow the steps below 
to configure your printer software for printing.

1. Open the file you want to print in the appropriate application.

2. Access the printer software from within the application.

Note:
For details on accessing the software, refer to the application’s user 
manual. In many applications, you can select Print directly from 
the File menu, then access the printer software by clicking the 
Properties button.

3. Click the Paper tab and select Roll Paper as Paper Source and 
appropriate page size.
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Note:
Do not select Sheet Feeder as the Paper Source setting in the 
printer software. Doing so will cause unnecessary paper to be fed 
after each print job. If you accidentally select Sheet Feeder, cut 
the paper off at the back of the printer before it feeds into the sheet 
feeder, then turn the printer power off and on again.

4. Make the Roll Paper Option settings at the bottom of the 
dialog box.

Paper 
Source

Roll Paper A 3-mm margin will be left along both 
sides of the paper.

No Margins No left or right margins will be left. Select paper size from 
the Paper size list.

Paper Size

Page Size

Select a predefined paper or page size from the list or 
define a custom size.

If you select a predefined paper or page size, when the 
data exceeds the selected size, it will be printed as 
individual pages on the roll paper. A 36-mm margin will 
be printed between each page of data in a print job when 
you press the z roll paper button.

Define a custom size by selecting User Defined in the list. 
This will open the User Defined Paper Size or User 
Defined Page Size dialog box where you can specify the 
length and width of your document. As long as your paper 
or page size is large enough, the data will be printed as 
one page. This will allow continuous printing of the data 
without page breaks.
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The Roll Paper Option settings are as follows:

5. Click the Main tab and select media that you use as the Media 
Type setting.

6. Click OK to close the printer software. Print your document 
and proceed to the next section, “Removing the Roll Paper 
from the Printer” on page 2-13.

Banner Mode Select this mode when you want to print multi-page 
data as continuous data on the roll paper, rather 
than as individual pages. When this check box is 
selected, the Save roll paper check box is enabled.

Cut Sheet Mode Select this mode when you want to print multi-page 
data as individual pages, rather than as continuous 
data. When this check box is selected, the Print 
page frame check box is enabled.

Save roll paper Select this check box when you do not want any 
paper to be fed after the data is printed. This 
feature is only available when Banner Mode is 
selected.

Print page frame Select this check box to print a line on the roll paper 
between pages in a multi-page document to 
indicate where the paper should be cut. This 
feature is useful when it is unclear where the page 
breaks should be or where the paper should be cut 
after the last page has been printed. This feature 
is only available when Cut Sheet Mode is selected.
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For Macintosh users

Note:
❏ The procedures described in this section may vary, depending upon 

the application that you are using. Check your application’s user 
manual for details.

❏ When printing on roll paper, you cannot use the Reverse Order 
or Rotate by 180°  features, select Maximum  or Centered  as the 
Printable Area setting, or use the functions in the Layout dialog box.

❏ Do not select PhotoEnhance  in the printer software, because it 
may cause offsets in the print area at logical page boundaries.

After the roll paper is loaded in the printer, make sure that the 
Stylus Photo 1290 or 890 is selected in the Chooser before 
proceeding. Follow the steps below to configure your printer 
software for printing.

1. Open the file that you want to print in the appropriate 
application.

2. Open the printer software.

Note:
In many applications, you can do this by selecting Page Setup  (or 
Print Setup ) on the File menu.
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3. Select Roll Paper as Paper Source and make the appropriate 
Paper Size setting. You can select either a predefined paper 
size or create a custom paper size.

4. Make the other settings as necessary. Refer to the table below 
for details. When finished, click OK.
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The Roll Paper Option settings are as follows:

5. Select Print on the File menu to open the Print dialog box.

Banner Mode Select this mode when you want to print multi-
page data as continuous data on the roll paper, 
rather than as individual pages. When this check 
box is selected, the Save roll paper check box is 
enabled.

Cut Sheet Mode Select this mode when you want to print multi-
page data as individual pages, rather than as 
continuous data. When this check box is selected, 
the Print page frame check box is enabled.

Save roll paper Select this check box when you do not want any 
paper to be fed after the data is printed. This 
feature is only available when Banner Mode is 
selected.

Print page frame Select this check box to print a line on the roll 
paper between pages in a multi-page document 
to indicate where the paper should be cut. This 
feature is useful when it is unclear where the page 
breaks should be or where the paper should be 
cut after the last page has been printed. This 
feature is only available when Cut Sheet Mode is 
selected.
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6. Make the appropriate Media Type setting, then click the Print 
button to print your document.

Note:
Click the  Preview icon button to change the Print button to a 
Preview button. Click the Preview button to see a preview of the 
printout.

Removing the Roll Paper from the Printer

After the print job is complete, press the z roll paper button; a 
line is printed on the roll paper indicating where to cut the paper. 
Follow the directions below to remove the paper from the printer.

1. Press the z roll paper button to feed the paper. This time, a 
cutting guide line is printed.
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Note:
❏ If you want to print more data on the same sheet of paper, press 

the z roll paper button and send the next print job. The paper 
will return to the printing start position before starting the next 
print job.

❏ You must press the z roll paper button; otherwise, the printer 
will not operate even if you send a new print job. However, do 
not press the z roll paper button more than is necessary; 
repeated motion may damage the printout.

2. Cut the paper along the printed line. Never pull the paper as 
you cut it. Doing so may damage the printout. When cutting 
the paper, do not cut inside the line (closer to the printer) as 
this may cause paper feed problems.

Note:
EPSON recommends that you use a triangle or other tool to ensure 
that the end of the roll is cut perpendicularly. A diagonal cut may 
cause paper feed problems.

3. Once you have cut the paper, hold down the z roll paper 
button for about 3 seconds. The paper feeds in reverse to a 
position where it can be easily removed from the sheet feeder 
at the back of the printer. If it does not feed to this position, 
repeat this step.

4. Gently remove the paper. Then, press the z roll paper button 
to clear error light.

Your document has now been printed.
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Storing EPSON Roll Paper

Return unused paper to the original package as soon as you finish 
printing. Also, EPSON recommends storing your printouts in a 
resealable plastic bag. Keep them away from high temperature, 
humidity, and direct sunlight.
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Chapter 3

Printing with Windows

Printer Software Introduction

The printer software which comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top operating condition.

The printer software features the menus, settings, and utilities 
shown below.

This chapter includes descriptions of the settings and utilities that 
are available on these menus.

If you encounter any problems when using the printer software, 
refer to the Technical Support Web Site for help by clicking 
Technical Support button on the Main menu of the printer 
software.

Menu Driver Settings

Main Media Type, Mode, Ink, Print Preview

Paper Paper Size, Copies, Orientation, Printable Area

Layout Reduce/Enlarge, Double-Sided Printing, Multi-Page, Watermark

Utilities

Utility EPSON Status Monitor 3, Nozzle Check, Head Cleaning, Print 
Head Alignment, Speed & Progress (dialog box)
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Getting more information

For information on using the printer software, see “Making 
Settings on the Main Menu” on page 3-4, “Making Settings on the 
Paper Menu” on page 3-20, or “Making Settings on the Layout 
Menu” on page 3-24.

For information on using the printer utilities, see “Using the 
Printer Utilities” on page 3-41.

Note:
The specific features available in the printer software vary depending on 
the version of Windows that you are using.

Online help provides more information about the printer 
software. See “Getting Information Through Online Help” on 
page 3-48 for instructions on accessing help.

Accessing the printer software

You can access the printer software from most Windows 
applications, or from the Windows Start menu.

When you access the printer software from a Windows 
application, the settings that you make apply only to the 
application you are using.

When you access the printer software from the Start menu, the 
settings that you make apply to all of your Windows applications.

Refer to the appropriate section below.
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From Windows applications

Follow the steps below to access the printer software.

1. Click Print or Print Setup on the File menu.

2. In the dialog box that appears, click Printer, Setup, Options, 
or Properties. (Depending on your application, you may 
need to click a combination of these buttons.) The printer 
software opens.

From the Start menu

Follow the steps below to access the printer software.

1. Click Start, point to Settings, then click Printers.

2. For Windows Me, 98, and 95 users, select your printer, then 
click Properties on the File menu.

For Windows 2000 users, select your printer, then click 
Printing Preferences on the File menu.

For Windows NT 4.0 users, select your printer, then click 
Document Defaults on the File menu.

The printer software opens.
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Making Settings on the Main Menu

You can make Media Type, Mode, Ink, and Print Preview settings 
on the Main menu. Refer to the appropriate section below.

Making the Media Type setting

The Media Type setting determines what other settings are 
available, so you should always make this setting first.

On the Main menu, select the Media Type setting that matches 
the media that is loaded in the printer. To find out what media 
type you are using, find your media in the list below found under 
“Plain Paper” on page 3-4, and refer to the corresponding media 
type under which it is grouped (shown in bold larger type). For 
some media, there are several Media Type settings to choose from.

Note:
For the latest information of the available media, visit our regional 
customer service web site. See “Regional Customer Services” on page 
10-33.

Plain Paper

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4)
EPSON Bright White Ink Jet Paper (A4)

S041214
S041442
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360 dpi Ink Jet Paper

Photo Quality Ink Jet Paper

EPSON 360 dpi Ink Jet Paper (A4) S041059

EPSON 360 dpi Ink Jet Paper (A3)* S041065
S041046

EPSON 360 dpi Ink Jet Paper (Super A3/SuperB)* S041066

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Iron-On Cool Peel Transfer Paper (A3)* S041238

EPSON Photo Quality Ink Jet Paper (A4) S041061

EPSON Photo Quality Ink Jet Paper (A3)* S041068

EPSON Photo Quality Ink Jet Paper 
(Super A3/Super B)*

S041069

EPSON Photo Quality Ink Jet Paper (B)* S041070

EPSON Photo Quality Ink Jet Cards (A6) S041054

EPSON Photo Quality Ink Jet Cards (5 × 8”) S041121

EPSON Photo Quality Ink Jet Cards (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheets (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 × 8” 
(with envelopes)

S041148

EPSON Ink Jet Greeting Cards 8 × 10” 
(with envelopes)

S041149
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Matte Paper-Heavyweight

Photo Paper

EPSON Matte Paper-Heavyweight (A4) S041256

EPSON Matte Paper-Heavyweight (B) S041266

EPSON Matte Paper-Heavyweight (A3)* S041260

EPSON Matte Paper-Heavyweight 
(Super A3/Super B)*

S041263

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (A3)* S041142

EPSON Photo Paper (Super A3/Super B)* S041143

EPSON Photo Paper (B)* S041156

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (4 × 6” No Perforations) S041458

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Photo Paper (89 mm × 7 M) S041281

EPSON Photo Paper (100 mm × 8 M) S041279

EPSON Photo Paper (210 mm × 10 M) S041280

EPSON Photo Paper (329 mm × 10 M)* S041233

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Photo Paper Cards (A4) S041177
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Photo Quality Glossy Film

Ink Jet Transparencies

Premium Glossy Photo Paper

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (A3)* S041073

EPSON Photo Quality Glossy Film (Super 
A3/Super B)*

S041074

EPSON Photo Quality Glossy Film (B)* S041075

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176

EPSON Ink Jet Transparencies (A4) S041063

EPSON Premium Glossy Photo Paper (A4) S041287

EPSON Premium Glossy Photo Paper (A3)* S041288

EPSON Premium Glossy Photo Paper (B)* S041290

EPSON Premium Glossy Photo Paper 
(Super A3/Super B)*

S041289

EPSON Premium Glossy Photo Paper 
(100mmx8M)

S041302

EPSON Premium Glossy Photo Paper 
(210mmx10M)

S041376

EPSON Premium Glossy Photo Paper 
(329mmx7M)*

S041378
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Ink Jet Black Light Film

* Only with the EPSON Stylus Photo 1290.

Making the Mode setting

The Mode settings on the Main menu are arranged to give you 
three levels of control over the printer software. The Mode 
settings are explained below.

In addition to making comprehensive Mode settings that affect 
overall print quality, you can also modify individual aspects of 
your printout using the Paper and Layout menus. See “Making 
Settings on the Paper Menu” on page 3-20 or “Making Settings on 
the Layout Menu” on page 3-24 for details.

Refer to the appropriate section below.

EPSON Ink Jet Back Light Film (A3)* S041131

Automatic This mode provides the quickest and easiest 
way to start printing. See “Using the 
Automatic mode” on page 3-9 for details.

PhotoEnhance This mode lets you choose from a variety of 
image-correction settings specially designed 
for photos. See “Using the PhotoEnhance 
mode” on page 3-10 for details.

Custom This mode lets you choose from a list of 
ready-made or personalized settings suited to 
the kind of document that you want to print. 
When Custom is selected, the Advanced 
button is enabled, allowing you to access the 
Advanced dialog box. See “Using the Custom 
mode” on page 3-11 for details.
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Using the Automatic mode

When Automatic is selected as the Mode setting on the Main 
menu, the printer software takes care of all detailed settings based 
on the current Media Type and Ink settings. To make the Ink 
setting, see “Making the Ink setting” on page 3-15. To make the 
Media Type setting, see “Making the Media Type setting” on page 
3-4.

Note:
❏ Depending on the media selected in the Media Type list (while 

Automatic is selected), a slider appears under the Custom radio 
button that lets you choose from Quality and Speed settings. 
Select Quality when print quality is more important than speed.

❏ Most Windows applications feature paper size and page layout 
settings that override similar settings in the printer software. 
However, if your application does not have these settings, verify the 
settings on the Paper menu of the printer software.
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Using the PhotoEnhance mode

The PhotoEnhance mode provides a variety of image-correction 
settings that you can apply to your photos before printing. 
PhotoEnhance does not affect your original data.

Note:
❏ This mode is only available when printing 8, 16, 24, and 32-bit color 

data.

❏ Printing with PhotoEnhance selected may increase the time 
required for printing, depending on your computer system and the 
amount of data contained in your image.

❏ Do not print using the PhotoEnhance mode while Roll Paper is 
selected as the Paper Source setting on the Paper menu.

You can select from the following settings.

Standard This setting provides standard image correction for most 
photos. Try this first.

People This setting is best for photos of people.
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Selecting PhotoEnhance also enables the Digital Camera 
Correction check box. Select this check box when you are printing 
photos taken with a digital camera to give your printed images 
the smooth, natural appearance of photographs taken with a film 
camera.

Using the Custom mode

Selecting Custom as the Mode option enables the Custom Settings 
list, from which you can select a color-matching method. You can 
also create and save your own custom settings. For details on 
making your own custom settings, see “Making the Advanced 
settings” on page 3-12.

Nature This setting is best for outdoor scenery such as mountains, 
sky, and oceans.

Soft Focus This setting makes your photos look as if they were taken 
with a soft-focus lens.

Sepia This setting applies a sepia tone to your photos.
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By default, you can choose from the following:

When you select a custom setting, other settings such as Print 
Quality and Color Adjustment are made automatically. Changes 
to these settings are reflected in the display at the left side of the 
Main menu.

Follow the steps below to select a custom setting.

1. Select Custom as the Mode setting on the Main menu.

2. From the Custom Settings list, select the most appropriate 
setting for the type of document or image that you want to 
print.

3. Verify the Media Type and Ink settings before printing, as 
they may be affected by the custom setting that you select. See 
“Making the Media Type setting” on page 3-4 or “Making the 
Ink setting” on page 3-15 for details.

Making the Advanced settings

The settings in the Advanced dialog box give you complete 
control over your printing environment. Use these settings to 
experiment with new printing ideas or to fine-tune a range of 
print settings to meet your individual needs. Once you are 
satisfied with your new settings, you can give them a name and 
add them to the Custom Settings list on the Main menu.

Ready-made setting Description

Economy This setting is best for printing drafts of text.

Color-matching method

ICM

(For Windows 98, 95, and 
2000)

This method automatically adjusts printout 
colors to match the colors on your screen. 
ICM stands for Image Color Matching.

sRGB This method is best for color matching with 
other sRGB devices.
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Follow the instructions in this section to make Advanced settings.

Note:
The printer software screens that appear in this procedure are for 
Windows Me, 98 and 95. The Windows 2000 and NT 4.0 printer 
software screens differ slightly in appearance.

1. Select Custom as the Mode setting on the Main menu and 
then click Advanced. The Advanced dialog box opens.

2. Select the Media Type that is loaded in the printer. For details, 
see “Making the Media Type setting” on page 3-4.

3. Choose Color or Black as the Ink setting.

4. Specify a Print Quality setting.

5. Make other settings as necessary. For details, see online help.
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Note:
❏ The PhotoEnhance feature only affects images, not text or 

graphs. For example, if Monochrome is selected from the Tone 
list (enabled when PhotoEnhance is selected), only the 
images in a document will be printed in monochrome. Any 
colored text or graphs in the same document will be printed in 
color.

❏ Some settings may be unavailable, depending on the Media 
Type, Ink, and Print Quality settings that you make.

6. Click OK to apply your settings and return to the Main menu. 
To return to the Main menu without applying your settings, 
click Cancel. To save your Advanced settings, proceed to the 
next section.

Saving and deleting your settings

To save your Advanced settings in the Custom Settings list, click 
Save Settings in the Advanced dialog box. The Custom Settings 
dialog box appears.
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Type a unique name for your settings in the Name text box, then 
click Save. Your Advanced settings will be added to the Custom 
Settings list.

Note:
❏ You cannot apply the names of EPSON ready-made settings or 

color-matching methods to your custom settings.

❏ You cannot delete the ready-made settings or color-matching 
methods from the Custom Settings list.

To delete a setting from the Custom Settings list, select it in the 
Custom Settings dialog box and click Delete.

Using your saved settings

To use your saved settings, select Custom as the Mode setting on 
the Main menu, then select your settings in the Custom Settings 
list, located to the right of the Custom radio button.

If you change the Media Type or Ink settings while one of your 
customized settings is selected in the Custom Settings list, the 
selection shown in the list returns to Custom Settings. The 
customized setting that was previously selected is not affected by 
the change. To return to your customized setting, simply reselect 
it in the list.

Making the Ink setting

To make the Ink setting, click Color to print in color, or Black to 
print in black-and-white or grayscale. 
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Previewing your printout

Select the Print Preview check box on the Main menu when you 
want to view a preview of your document before printing.
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When you send a print job to the printer, the EPSON Print 
Preview window opens, allowing you to make changes before 
printing.

The EPSON Print Preview toolbar contains several icon buttons 
which you can use to perform the following functions.

Selection Click this button to select and move 
watermarks.

Zoom Click this button to enlarge or reduce the 
size of the previewed page.

Fit-to-screen Click this button to scale the previewed page 
so that it fits the size of the window. This is 
convenient when you want to see the entire 
page at one time.

Maximum 
zoom

Click this button to display the previewed 
page at the maximum possible zoom ratio.

Printable 
area on/off

Click this button to display a rectangle on the 
page being previewed. This rectangle is the 
printable area for the page. The printer 
cannot print anything which is outside of this 
rectangle. Click the button again to turn this 
feature off.
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You can also manipulate the previewed document in the 
following ways:

❏ Select and preview individual pages.

❏ Reduce or enlarge the size of the preview.

❏ Select and print any or all pages.

❏ Magnify the previewed document. To do this, click View and 
then Magnify to open the Magnify window, which magnifies 
the area of the previewed document that is outlined by the 
red box. By dragging the red box, you can change which part 
of the document is magnified.

❏ View the individual pages that comprise a poster. The Poster 
window opens automatically when you send a print job while 
Poster is selected as the Multi-Page option on the Layout 
menu. From this window, you can view the individual pages 
which make up a poster. You can also open this dialog box by 
clicking View and then Poster.

Watermark Click this button to open the Watermark 
Settings dialog box, where you can change 
any of the current watermark settings.

Reset 
watermark 
settings

Click this button to return all watermark 
settings to what they were when the EPSON 
Print Preview dialog box was first opened. If 
no settings have been changed, this feature 
is not available.

Previous 
page

Click this button to display the page previous 
to the one currently being previewed. If there 
is no previous page, this feature is not 
available.

Next page Click this button to display the next page in 
the document. If there is no next page, this 
feature is not available.
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❏ Apply watermarks. The watermark that you select will be 
displayed on the previewed image. For detailed information 
on customizing watermarks, see “Making the Watermark 
setting” on page 3-38. 

❏ Specify which pages in the document you would like to print 
using the Add and Remove features. To add or remove a page, 
click the page icon in the list at the left side of the preview 
window. Then, add or remove it using the commands on the 
Print Options menu. The Print Options menu commands are 
as follows.

Note:
❏ When using the double-sided printing feature, the Preview window 

allows you to toggle between pages in a print job by clicking the 
appropriate page in the list at the left side of the screen. The pages 
are listed in two columns, Front and Back. The pages in the Front 
column will print first. The page numbers listed refer to pages of the 
print job and may contain more than one document page.

❏ If it is necessary to reprint part of a double-sided print job, select 
each page of the print job that does not need to be reprinted in the 
list at the left side of the screen, then click Remove Page on the 
Print Options menu. Make sure that the paper is loaded properly so 
that the print job will start on the correct side of the correct page.

After you have previewed the document, click Print to print the 
document, or click Cancel to cancel printing.

Add page Click this button to add the highlighted 
pages to the list of pages to be printed. 

Remove 
page

Click this button to remove the highlighted 
pages from the list of pages to be printed.
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Making Settings on the Paper Menu

Use the settings on the Paper menu to change the paper size, set 
the number of copies and other copy parameters, specify the 
paper orientation, and adjust the printable area.

The settings which are available vary depending upon whether 
the sheet feeder or the roll paper is selected as the Paper Source 
setting.

When you select Sheet Feeder as the Paper Source setting, the 
printer software will appear as shown below.
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When you select Roll Paper as the Paper Source setting, the printer 
software will appear as shown here.

You can make the following settings on the Paper menu:

Paper Source Select the paper source that you want to use from the 
selections below.

Sheet Feeder:
Select this to leave a 3-mm margin on both the right and 
the left sides of the paper. This option is available when 
printing on normal paper.

Roll Paper:
Select this to leave a 3-mm margin on both the right and 
the left sides of the roll paper. 
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No Margins Check this box when you want to print with no margins.

Sheet Feeder :
Select this to leave no margins on full  side of the paper. 
This option is available only when printing with paper that 
is in the Paper size list. 

Roll Paper:
Select this to leave no margins on full side of the roll 
paper. This option is available only when printing with 
paper that is on the Paper size list.

You can use the following media with this feature. 

(Available paper sizes vary depending on your printer 
model.)

Photo Paper:
Super A3/Super B*, A3*, Panoramic, A4, Letter, 4 x 6” 
(No Perforations), 100 x 150 mm

Matte Paper-Heavyweight:
Super A3/Super B*, A3*, A4, Letter

Index Card:
5 x 8”

* only with the EPSON Stylus Photo 1290.

Note
If your application has margin settings, make sure they 
are set to zero before printing.

When using this feature with Roll Paper, you need to use 
your image-editing software to make the image 4mm 
wider than the roll paper.

Printing with this feature selected takes longer than for 
normal printing.

Because this feature enlarges the image to a size slightly 
larger than the paper size when Sheet Feeder is selected 
as the Paper Source setting, the portion of the image that 
extends beyond the edges of the paper will not be printed.

Print quality may decline in the top and bottom areas of 
the printout, or the area may be smeared when printing 
on media other than listed above. We recommend printing 
a single sheet to check quality before printing large jobs.

You cannot use this feature with the following media: 
Photo Quality Glossy Film, Ink Jet Transparencies, Iron-
On Cool Peel Transfer Paper, Ink Jet Back Light Film, or 
360 dpi Ink Jet Paper.

Paper Size Select the paper size that you want to use. You can also 
add a custom paper size.
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Copies Select the number of copies that you want to print. You 
can select Collate to print one set at a time or Reverse 
Order to print your documents in reverse order, starting 
with the last page.

Orientation Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout. To print closer to the bottom 
of the page, select the Rotate by 180° check box.

Printable Area Use this option in the Printable Area Box to adjust the total 
area available for printing when sheet Feeder is selected 
as the Paper Source setting. This feature is not available 
when No Margins or Roll Paper is selected.

To center the printout, select Center. To increase the 
printable area at the bottom edge from 14mm to 3mm, 
select Maximum. Do not select Maximum while using 
Premium Glossy Photo Paper or Ink Jet Back Light Film 
(Stylus Photo 1290).

Note:
The print quality may decline at the edges of the printout 
when Maximum is selected as the Printable Area setting. 
Before printing large jobs using this setting, print a single 
sheet to confirm quality.
When Maximum is selected, make sure that the paper 
loaded in the sheet feeder is not curled. 
If you select Maximum when printing on Premium Glossy 
Photo Paper, your printout may be smeared in the 
expanded area (between 14 mm and 3 mm from the 
bottom edge)..
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Making Settings on the Layout Menu

You can make Reduce/Enlarge, Double-Sided Printing, Multi-
Page, and Watermark settings on the Layout menu. Refer to the 
appropriate section below.

Roll Paper 
Option

The Roll Paper Option settings are only available when 
Roll Paper is selected as the Paper Source setting. These 
features are not available when Sheet Feeder is selected.

The available settings are described below.

Banner Mode:
Select this mode when you want to print multi-page data 
as continuous data on the roll paper, rather than as 
individual pages. When this check box is selected, the 
Save roll paper check box is enabled.

Cut Sheet Mode:
Select this mode when you want to print multi-page data 
as individual pages, rather than as continuous data. 
When this check box is selected, the Print page frame 
check box is enabled.

Save roll paper:
Select this check box when you want to save roll paper. 
When this check box is selected, the blank portion of the 
last page of your document is not fed through the printer. 
This feature is only available when Banner Mode is 
selected.

Print page frame:
Select this check box to print a line on the roll paper 
between pages in a multi-page document to indicate 
where the paper should be cut. This feature is useful when 
it is unclear where the page breaks should be. This 
feature is only available when Cut Sheet Mode is 
selected.
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Making the Reduce/Enlarge setting

Use the Reduce/Enlarge options on the Layout menu to fit your 
document to the paper size that you will print on.

You can select from the following settings.

Normal Prints your document at its normal size.

Fit to Page Proportionally enlarges or reduces the size of your 
document to make it fit the paper size you select in 
the Paper Size list on the Paper menu.

Custom Allows you to manually reduce or enlarge an 
image. Click the arrows next to the Scale to box to 
select a percentage between 10% and 400%.
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Making the Double-Sided Printing setting

There are two types of double-sided printing available. Standard 
double-sided printing allows you to print the odd-numbered 
pages first. Once these are printed, you can reload the printouts 
in the sheet feeder and print the even-numbered pages on the 
other side of the paper. Folded booklet double-sided printing 
allows you to make single-fold booklets. Refer to the appropriate 
section below.

Note:
❏ The double-sided printing feature is not available when the printer 

is accessed over a network or is used as a shared printer.

❏ You can load up to 30 sheets of paper at one time when double-sided 
printing; however, the loading capacity of the sheet feeder varies, 
depending on the media type.

❏ Only use media types which are suitable for double-sided printing. 
Otherwise, the printout quality may deteriorate.

❏ Depending on the type of paper and the amount of ink used to print 
text and images, ink may bleed through to the other side of the paper.

Standard double-sided printing

Follow the steps below to print first the odd-numbered pages and 
then the even-numbered pages after you have reloaded the 
printouts.
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1. Select the Double-Sided Printing check box on the Layout 
menu of your printer software. For information on accessing 
the Layout menu, see “Accessing the printer software” on 
page 3-2.

2. Click the Margins button. The following dialog box opens.

3. Specify which edge of the paper the binding will be on. You 
can choose between Left, Top, and Right.
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4. Specify the width of the binding margin by entering a value 
in the Binding Margin text box. You can specify a value 
between 3 mm and 30 mm. 

Note:
The actual binding margin may vary, depending on your 
application. Experiment by printing a few sheets using different 
binding margin values before printing the entire job; otherwise, the 
results may differ from what you expect.

5. Click OK to return to the Layout menu, then click OK to save 
your settings.

6. Load paper in the sheet feeder, then send the print job from 
your application. While the printer is printing the odd-
numbered pages, instructions are displayed which explain 
how to reload the paper correctly.

7. Follow the instructions to reload the paper, or reload the 
paper as shown in the illustration below.

Note:
❏ The paper may curl during printing, depending on the amount 

of ink used to print text and images. Flatten it or curl it slightly 
toward the opposite side before printing on the other side of the 
paper.

❏ Tap the stack of paper on a flat surface to align the edges before 
reloading it.

❏ Reload the printouts as instructed; otherwise, the paper may 
jam or the binding margin may differ from what you expect.
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❏ If the paper jams, see “Cancelling Printing” on page 10-29.

8. Once the paper is reloaded, click Resume to print the even-
numbered pages.

Folded booklet double-sided printing
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You can also make single-fold booklets using the double-sided 
printing feature. When booklet printing, the printer first prints 
the pages which will be on the outside after you fold the paper 
and then prints the inside pages after you reload the paper, as 
shown in the illustration below.

In this example, the printer would print pages 1 and 4 of your 
document on the first sheet of paper, pages 5 and 8 on the second 
sheet of paper, and pages 9 and 12 on the third sheet of paper. 
After you reload the printouts in the sheet feeder, the printer 
would then print pages 2 and 3 on the back of the first sheet of 
paper, pages 6 and 7 on the back of the second sheet of paper, and 
10 and 11 on the back of the third sheet of paper. After printing is 
complete, you can fold each sheet of paper and then bind the 
pages together.

Follow the steps below to print booklets.

1. Select the Double-Sided Printing check box on the Layout 
menu, then select the Folded Booklet check box.

2. Click the Margins button. The Margins dialog box opens.

Single-fold booklet

Binding Edge

1

2 4

3 5 9

6

7

8 10

11

12
3-30 Printing with Windows



3. Specify which edge of the paper the binding will be on. You 
can choose between Left, Top, and Right.

Note:
While Portrait is selected as the Orientation setting on the Main 
menu of your printer software, you can choose between Left and 
Right. While Landscape is selected, you can only select Top.

4. Specify the width of the binding margin by entering a value 
in the Binding Margin text box. You can specify a value 
between 3 mm and 30 mm. This margin width will be inserted 
on both sides of the fold. For example, if you specify a value 
of 10 mm, a 20-mm margin will be inserted, with 10 mm on 
each side of the fold.

5. Click OK to return to the Layout menu, then click OK to save 
your settings. 

6. Load paper in the sheet feeder, then send the print job from 
your application.

Margin

Folding 
Edge

Portrait Landscape
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7. While the printer is printing the outside pages, instructions 
are displayed which explain how to reload the paper 
correctly. Follow the on-screen instructions to reload the 
paper, or reload the paper as shown in the illustration in the 
previous section, “Standard double-sided printing” on page 
3-26. 

Note:
❏ The paper may curl during printing, depending on the amount 

of ink used to print text and images. Flatten it or curl it slightly 
toward the opposite side before printing on the other side of the 
paper.

❏ Tap the stack of paper on a flat surface to align the edges before 
reloading it.

❏ Reload the printouts as instructed; otherwise, the paper may 
jam or the binding margin may differ from what you expect.

❏ If the paper jams, see “Cancelling Printing” on page 10-29.

8. Once the paper is reloaded, click Resume to print the inside 
pages. 

9. Once printing is complete, fold the printouts properly and 
bind them together using a stapler or other binding method.

Making the Multi-Page setting

Selecting the Multi-Page check box allows you to choose between 
the N-up and Poster settings. Refer to the appropriate section 
below.

Making the N-up setting
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Select N-up as the Multi-Page setting on the Layout menu to print 
two or four pages of your document on one sheet of paper.

To print more than one page on a piece of paper, you should make 
the following settings:

Making the Poster setting

2 Pages
4 Pages

Prints two or four pages of your document on a 
single piece of paper.

Page Order Opens the Print Layout dialog box, where you can 
specify the order in which the pages will be printed 
on the sheet of paper. Some settings may be 
unavailable, depending upon your Orientation 
selection on the Paper menu.

Print page 
frames

Prints a frame around each page that is printed on 
the sheet of paper.
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A single document page can be enlarged to cover 4, 9, or 16 
printed sheets of paper. Select Poster as the Multi-Page setting to 
print a poster-size image.

Click the Settings button to adjust the way your poster will print. 
The Poster Settings dialog box opens.

You can make the following settings.

Print Cutting 
Guides

Check this box to turn the cutting guide options on.

Overlapping 
Alignment Marks

Slightly overlaps the images and prints alignment 
markers so that they can be aligned more precisely.

Trim Lines Prints border lines on the images to guide you when 
trimming the pages.
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If you only want to print a few of the panels without printing the 
entire poster, click the panels that you do not wish to print, then 
click OK to close the Poster Settings dialog box.

How to make a poster from your printouts

Here is an example of how to make a poster from 4 sheets of your 
printout. Refer to the accompanying illustrations as well.

1. Vertically cut the margin of Sheet 1 along the line connecting 
the alignment markers as shown in the illustration.
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2. Place Sheet 1 on Sheet 2 and align the cross markers on both 
sheets, then temporary tape them from the back side of the 
paper. 

3. Cut off the taped sheets along the line between the alignment 
markers.

4. Align the paper using the alignment markers and tape them 
from the back side of the paper.

5. Repeat the instructions from step 1 to step 4 to tape Sheets 3 
and 4 as well.
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6. Repeat the instructions from step 1 to step 4 to tape top and 
bottom faces of the paper.

7. Cut off the remaining margins.

c
Caution:
Be careful when using edged tools.
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Making the Watermark setting

To print a watermark on your document, click anywhere in the 
Watermark list box on the Layout menu, and select from the list 
of predefined watermarks that appears.
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You can also add your own text-based or image-based 
watermarks to the Watermark list. To add a watermark, click the 
Add/Del button. The following dialog box appears.

Refer to the appropriate section below to finish creating a custom 
watermark.

Creating an image-based watermark

Follow the steps below to create an image-based watermark.

1. Select BMP.

2. Click the Browse button to specify the bitmap file you want 
to use, then click OK.

3. Type a name for your watermark in the Name box, then click 
Save. Click OK to return to the Layout menu.

Creating a text-based watermark
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Follow the steps below to create a text-based watermark.

1. Select Text.

2. Type your text in the Text box. The text that you enter will 
also be assigned to the watermark as the watermark name.

3. If you want to change the watermark name, type a new name 
in the Name box, then click Save. Click OK to return to the 
Layout menu.

Making settings for your watermark

Follow the steps below to make settings for your watermark.

1. Select the desired watermark in the Watermark list box on the 
Layout menu.

2. Click the Settings button. The following dialog box appears.
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3. Make sure that the appropriate watermark is selected in the 
Watermark list box, then make Color, Position, Density, Size, 
Font, Font Style, and Angle settings. For details, please see 
online help. Your settings are reflected in the display at the 
left side of the dialog box.

4. When you are finished making settings, click OK.

Using the Printer Utilities

EPSON printer utilities allow you to check the current printer 
status and to perform some printer maintenance from your 
computer.

To use the utilities, click the Utility tab in the printer software, 
then click the button for the utility that you want to use. For 
information on how to access the printer software, see “Accessing 
the printer software” on page 3-2.
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Note:
❏ The letter in parentheses after the utility name indicates the shortcut 

key for that utility. Press Alt and the letter on the keyboard to open 
that utility.

❏ Do not use the Nozzle Check, Head Cleaning, or Print Head 
Alignment utilities if your printer is connected to your computer 
through a network.

❏ Do not use the Nozzle Check, Head Cleaning, Print Head 
Alignment, or Ink Cartridge Replacement utilities while printing is 
in progress; otherwise, your printout may be marred.

Refer to the appropriate section below.

Status Monitor 3

Status Monitor 3 provides you with printer status information, 
such as the amount of ink remaining, and checks for printer errors.

This utility is only available when both of the following conditions 
are met:

❏ The printer is connected directly to the host computer via the 
parallel or USB port.

❏ Your system is configured to support duplex communication.

Nozzle Check

The Nozzle Check utility checks the print head nozzles for 
clogging. Check the nozzles if you notice print quality has 
declined and after cleaning to confirm that the print head nozzles 
have been cleared. If the nozzle check indicates the print head 
needs cleaning, you can access the Head Cleaning utility directly 
from the Nozzle Check utility. For details, see “Checking the Print 
Head Nozzles” on page 9-1.
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Head Cleaning

The Head Cleaning utility cleans the print head. You may need 
to clean the print head if you notice print quality has declined. 
Use the Nozzle Check utility first to confirm that the print head 
needs to be cleaned. You can access the Nozzle Check utility 
directly from the Head Cleaning utility. For details, see “Cleaning 
the Print Head” on page 9-3.

Print Head Alignment

The Print Head Alignment utility aligns the print head. Use this 
utility if you notice a misalignment of vertical lines. Follow the 
on-screen instructions to use this utility.

Printer and Option Information

This utility allows the printer driver to confirm printer 
configuration information. It also provides specific information 
regarding certain characteristics of the printer, such as the Printer 
ID.
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Depending on the configuration of your system, the information 
displayed in the Printer and Option Information dialog box may 
be updated automatically, or may need to be entered manually.

If a message appears in the Current Settings window prompting 
you to enter settings, or if you change the printer configuration, 
follow the steps below to make the necessary settings manually.

1. Click the Settings Sheet button in the Printer and Option 
Information dialog box to print out information about your 
printer and options. This requires that A4 size paper is loaded 
in your printer. You will see a printout similar to the one 
below.

2. Make sure the settings in the utility match the information on 
the printed Settings Sheet. If they do not match, correct the 
settings on the screen to match the information on the settings 
sheet.

3. Click OK to exit this menu and save your settings.
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Speed & Progress

You can make settings related to print speed and progress in this 
dialog box.

The available settings are as follows:

High Speed Copies

To print multiple copies of your document faster, select High 
Speed Copies. This speeds up printing by using your hard disk 
space as a cache when printing multiple copies of your document.

EPSON Printer Port (for Windows Me, 98 and 95 only)

To speed up the data transfer rate to EPSON printers, select 
EPSON Printer Port.

If your computer supports ECP mode, enable DMA transfer to 
speed up printing.
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For more details on the EPSON Printer Port setting, see “EPSON 
Printer Port (For Windows Me, 98 and 95 only)” on page 3-51. For 
details on enabling DMA transfer, see “Use DMA transfer (For 
Windows Me, 98 and 95 only)” on page 3-51

Always spool RAW datatype (for Windows 2000 and NT 4.0 
only)

Select this check box to have Windows NT-based clients spool 
documents using the RAW format instead of the EMF (metafile) 
format (Windows NT-based applications use the EMF format by 
default).

Try using this option if documents spooled in EMF format do not 
print correctly.

Spooling RAW datatype requires less resources than EMF, so 
some problems (“Insufficient memory/disk space to print”, 
“Slow print speed”, etc.) can be solved by selecting the Always 
spool RAW datatype check box.

When spooling RAW datatype, print progress as displayed by the 
Progress Meter may differ from actual print progress.

Monitoring Preferences
3-46 Printing with Windows



Click this button to open the Monitoring Preferences dialog box, 
where you can make settings for EPSON Status Monitor 3. 

You can make the following settings:

Select 
Notification

Displays the current error item notification settings.

In this area, you can designate whether to have general error 
messages, communication error messages, or ink status 
messages displayed during printing or copying. Select the 
appropriate check box to specify the error types for which 
you want to receive notification. Also select the Alert check 
box if you want to be notified of error messages with an audio 
alert.

Select 
Shortcut 
Icon 

Select this check box to have a shortcut icon placed in your 
Windows taskbar. Click the shortcut icon in the taskbar to 
open EPSON Status Monitor 3. Right-click the icon to display 
a shortcut menu, from which you can access some of the 
printer utilities. To select which icon will be displayed, click 
the icon your prefer from the choices given; your selection 
will be displayed at the right.
Printing with Windows 3-47



Note:
Click the Default button to revert all Select Notification settings to their 
defaults.

Getting Information Through Online Help

Your printer software has an extensive online help feature, which 
provides you with instructions on printing, making printer driver 
settings, and using printer utilities.

Refer to the appropriate section below.

Accessing help from your application

Open the File menu and choose Print or Print Setup. Then, click 
Printer, Setup, Options, or Properties. (Depending on your 
application, you may need to click a combination of these 
buttons.) Click Help at the bottom of the Main, Paper, Layout, or 
Utility menu for help related to the items on that menu.

You can get specific help related to any item on a menu by right-
clicking the item and then clicking the What’s This?  command.

Accessing help from the Windows Start menu

Click the Start  button, point to Programs  and Epson  (for 
Windows Me, 98, and 95) or EPSON Printers  (for Windows 2000 
and NT 4.0), then click EPSON Stylus Photo 1290 Help  or 890 
Help . The help contents window opens.

Allow 
monitoring 
of shared 
printers

Select this check box to allow monitoring of a shared printer 
by other computers.
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Increasing the Print Speed

Follow the instructions in this section to increase the printing 
speed of your printer.

General tips

Just as printing at a high resolution requires more processing time 
than printing at a low resolution, printing in color takes longer 
than printing in black-and-white because the volume of data in a 
color document is much greater. For this reason, it is important 
to be selective in your use of color if you also require a fast print 
speed.

However, even if your document requires the highest resolution 
and extensive use of color—for example, when you are printing 
a camera-ready composite that includes color photographs—it 
may still be possible to optimize the print speed by adjusting other 
printing conditions. Keep in mind that changing some conditions 
to increase the print speed may also lower print quality.

The following table shows the factors that inversely affect print 
speed and print quality (increasing one will decrease the other).

Print quality
Print speed

Lower
Faster

Higher
Slower

Printer 
software 
menu

Printer 
software 
settings

Print Quality Economy, 
Normal

Photo Advanced 
dialog box

High Speed On Off

Finest Detail Off On

Data 
characteristics

Image size Small Large –

Resolution Low High
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The table below shows the factors related to print speed only.

 * Varies depending on the printer software and application that you are using.

** Grayscale means using black ink only to print varying shades of gray, from 
pure black to pure white.

Print speed Faster Slower Printer 
software 
menu

Printer 
software 
settings

Ink Black Color Advanced 
dialog box, 
Main menu

Flip Horizontal* Off On Advanced 
dialog box

Collate* Off On Paper menu

Reverse Order* Off On

Data 
characteristics

Variety of colors Grayscale** Full color –

Hardware 
resources

System speed Faster Slower –

HDD free space Large Small

Memory free 
space

Large Small

Software 
status

Running 
applications

One Many –

Virtual memory Not in use In use
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Making the Speed & Progress settings

You can make certain print speed settings in the Speed & Progress 
dialog box. Click the Speed & Progress button on your printer 
software’s Utility menu. The following dialog box appears.

The available settings that are related to print speed are as follows:

High Speed Copies

To print multiple copies of your document faster, select High 
Speed Copies. This speeds up printing by using your hard disk 
space as a cache when printing multiple copies of your document.

EPSON Printer Port (For Windows Me, 98 and 95 only)

Select this check box to enable the EPSON printer port, which is 
optimized for EPSON printers, instead of the Windows default 
printer port. This speeds up the data transfer rate to EPSON 
printers.

Use DMA transfer (For Windows Me, 98 and 95 only)
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If your computer has a parallel port which supports ECP mode, 
you can enable DMA transfer to speed up printing. See your 
computer manual to determine if it supports ECP mode and DMA 
transfer.

To determine whether you need to enable DMA transfer, compare 
the message below the EPSON Printer Port check box to this 
table, and take the recommended action.

If you want to enable DMA transfer, follow the steps below.

1. Double-click the My Computer icon on your desktop and 
then Control Panel.

2. Double-click the System icon and click the Device Manager 
tab.

3. Double-click the Ports (COM & LPT) icon and then the LPT1 
icon. If your printer is connected to a port other than LPT1, 
double-click the appropriate port icon.

Message Action

High Speed (DMA) 
Transfer enabled.

DMA transfer is already enabled. Click OK to 
close the dialog box.

For higher data transfer 
rates, use DMA Transfer.

Follow the steps below this table to enable 
DMA transfer.

(No message) Your system’s parallel port setting does not 
allow DMA transfer. However, if you change 
the parallel port setting to ECP or Enhanced 
using your computer’s BIOS Setup program, 
you may be able to use DMA transfer. Consult 
your computer manual or computer 
manufacturer for instructions. Once you 
change the parallel port setting, follow the 
steps below this table to enable DMA transfer.

Note:
Before you run the BIOS Setup program, 
uninstall the printer software using 
Add/Remove Programs in the Control Panel. 
After running the BIOS Setup program, 
reinstall the printer software.
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4. Click the Resources tab, then clear the Use automatic 
settings check box. Write down the Input/Output Range 
settings shown in the resource settings box.

5. Select a basic configuration setting from the Setting based on 
list that uses the same Input/Output Range settings as those 
you wrote down in Step 4, and make sure that the Direct 
Memory Access channel and Interrupt Request numbers are 
allocated and displayed. Confirm also that the Conflicting 
device list text box shows No conflicts.

6. Click OK to save the settings.

7. Reopen the Speed & Progress dialog box to verify whether 
DMA transfer has been enabled.

Note:
You may not be able to use DMA transfer on some computers even 
after you make the settings explained above. Consult your computer 
maker for information on the DMA transfer capability of your 
computer.
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Using Port Configuration (Windows NT 4.0 only)

Note:
Port settings are complicated and should only be made by an experienced 
user with administrative privileges.

If your computer has a parallel port that supports ECP mode, you 
can make certain print speed settings in the Port Configuration 
dialog box. Before making settings, make sure that ECP mode is 
selected in your computer settings. For details about ECP mode, 
see your computer manual.

To access the Port Configuration dialog box, click the Start button, 
point to Settings, and click Printers. Then, select your printer 
and click Properties on the File menu. The printer software 
opens. Click the Ports tab, then click Configure Port. The 
following dialog box appears.

Click the LPT port tab for the port to which your printer is 
connected, then click the Port Configuration button.
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Note:
If your printer is connected to LPT1, only the LPT1 tab is available.

The available settings are as follows:

Resource settings (IRQ and DMA)

If you have connected your printer to LPT2 or LPT3, making IRQ 
and DMA settings here may speed up printing. Click Change 
setting and input the same configuration numbers for IRQ and 
DMA which you have made with your expansion board. See your 
computer documentation to determine the settings for IRQ and 
DMA.

Use DMA transfer

Using DMA transfer to send print data to the computer may help 
speed up printing. If the Use DMA Transfer check box is not 
enabled, you must first enable DMA transfer in your computer 
settings. For details, see your computer documentation.
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Chapter 4

Checking Printer Status and Managing 
Print Jobs for Windows

Using the Progress Meter

When you send a print job to the printer, the Progress Meter 
opens, as shown in the illustration below.

The Progress Meter indicates the progress of the current print job 
and provides printer status information when bidirectional 
communication between the printer and computer is established. 
This meter also displays helpful tips for better printing and error 
messages. Refer to the appropriate section below.
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Epson Printing Tips

Tips for getting the most out of your EPSON printer software 
appear in the text box at the bottom of the Progress Meter 
window. A new tip appears every 30 seconds. For more details 
on a tip which is currently displayed, click the Details button.

Error messages

If a problem occurs during printing, an error message appears in 
the text box at the top of the Progress Meter window. For more 
detailed information, click Technical Support to access to the 
Technical Support Web Site for help. 

When the ink runs low or out, a How to button appears below the 
text box. Click How To and EPSON Status Monitor 3 will lead you 
step-by-step through the cartridge replacement procedure.
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Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If 
it receives two or more print jobs at one time, it holds them in the 
order that they were received (with printers on a network this 
may be called a print queue). When a print job reaches the top of 
the line, the EPSON Spool Manager sends the job to the printer. 
From the Spool Manager, you can view print status information 
about the print jobs which have been sent to your printer. You can 
also cancel, pause and resume, or restart selected print jobs.

Note:
EPSON Spool Manager is not available for Windows 2000 or 
Windows NT.

For Windows Me, 98 and 95

After you send a print job, an EPSON Stylus Photo 1290 or 890 
button appears on the taskbar. Click this button to open the 
EPSON Spool Manager.
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Using EPSON Status Monitor 3

EPSON Status Monitor 3 displays detailed information on the 
printer status.

Note:
Before using EPSON Status Monitor 3, be sure to read its README 
file. To open this file, click Start, point to Programs and then to 
EPSON or EPSON Printers, then click EPSON Stylus Photo 1290 
or 890 Readme.

Accessing EPSON Status Monitor 3

There are two ways to access EPSON Status Monitor 3:

❏ Double-click the printer-shaped shortcut icon on the 
Windows taskbar. For details, see “Monitoring Preferences” 
on page 3-46.

❏ Open the printer software, click the Utility tab, then click the 
EPSON Status Monitor 3 button.

When you access EPSON Status Monitor 3, the following window 
appears.
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Viewing information in EPSON Status Monitor 3

EPSON Status Monitor 3 provides the following information.

❏ Current Status:
EPSON Status Monitor 3 provides you with detailed printer 
status information, a graphic display, and status messages. If 
the ink runs low or out, the How to button appears in the 
EPSON Status Monitor 3 window. Clicking How to displays 
ink cartridge replacement instructions and moves the print 
head to the ink cartridge replacement position.

❏ Ink Levels:
EPSON Status Monitor 3 provides a graphic display of the 
amount of ink remaining. 

Note:
❏ EPSON Status Monitor 3 provides an estimate of the number 

of pages that can be printed, based on the amount of ink 
remaining. For the color ink cartridge, the chamber with the 
least amount of ink remaining determines the level that is 
displayed for all of the colors in the cartridge.

❏ When you install a Light Capacity ink cartridge, the Ink Level 
display will show that the cartridge is only half full. This is 
because a Light Capacity ink cartridge only contains half of the 
amount of ink as a regular cartridge.

❏ Ink Cartridge Information:
You can view information about the installed ink cartridges 
by clicking the Information icon.

❏ Technical Support:
You can access the Technical Support Web Site from EPSON 
Status Monitor 3. If you encounter a problem, click Technical 
Support in the EPSON Status Monitor 3 window.
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Chapter 5

Using the Printer Software for Macintosh

Printer Software Introduction

The printer software which comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top operating condition.

Accessing the printer software

The printer software features the primary dialog boxes, settings, 
and utilities shown below.

These dialog boxes can be accessed as described below.

Dialog Box Driver Settings

Print Media Type, Mode, Copies, Pages, Ink

Page Setup Paper Size, Orientation, Rotate by 180 degrees, Double-
Sided Printing, Reduce or Enlarge, Printable Area

Layout Fit to Page, Watermark, Multi-Page, Print Order

Utilities

Utility EPSON Status Monitor, Nozzle Check, Head Cleaning, Print 
Head Alignment, Configuration (dialog box)

Dialog Box How to Access It

Print Click Print on the File menu of your application or click Options 
in the Page Setup dialog box.

Page Setup Click Page Setup on the File menu of your application
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In addition, the dialog boxes below are accessed from the Print 
dialog box.

This chapter includes descriptions of the settings and utilities that 
are available in these dialog boxes. Refer to the appropriate 
section below.

You can also get more information about the printer software by 
clicking the help icon in any of the dialog boxes in the printer 
software.

If you encounter any problems when using the printer software, 
refer to the EPSON Technical Support Web Site. To access the web 
site from the printer software CD-ROM, insert the CD-ROM in 
the CD-ROM drive and open the Install Printer Driver/Utility 
folder in the EPSON folder, and then double-click the Technical 
Support Web Site icon.

Layout Click the  Layout icon button in the Print dialog box

Utility Click the  Utility icon button in the Print or Page Setup 
dialog box

Dialog Box How to Access It

Background 
Printing

Click the  Background Printing icon button in the Print 
dialog box

Preview Click the  Preview icon button in the Print dialog box 
and then click Preview

Save File Click the  Preview icon button in the Print dialog box 
until the Print button changes into the Save File button and 
then click the Save File button.
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Making settings in the Print dialog box

You can make Media Type, Mode, Ink, Copies, and Pages settings 
in the Print dialog box. From this dialog box, you can also access 
other dialog boxes, from which you can set the print time, preview 
the document before printing, and save spool data as a file. Refer 
to the appropriate section below.

Making the Media Type setting

The Media Type setting determines what other settings are 
available, so you should always make this setting first.

In the Print dialog box, select the Media Type setting that matches 
the paper that is loaded in the printer. To find out what media 
type you are using, find your media in the list below found under 
“Plain Paper” on page 5-3, and refer to the corresponding media 
type under which it is grouped (shown in bold larger type). For 
some media, there are several Media Type settings to choose from.

Note:
For the latest information of the avaiable media, visit our regional 
customer service web site. See “Regional Customer Services” on page 
10-33 for details.

Plain Paper

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4)
EPSON Bright White Ink Jet Paper (A4)

S041214
S041442
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360 dpi Ink Jet Paper

Photo Quality Ink Jet Paper

EPSON 360 dpi Ink Jet Paper (A4) S041059

EPSON 360 dpi Ink Jet Paper (A3)* S041065

EPSON 360 dpi Ink Jet Paper (Super A3/Super B)*S041066

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Iron-On Cool Peel Transfer Paper (A3)* S041238

EPSON Photo Quality Ink Jet Paper (A4) S041061

EPSON Photo Quality Ink Jet Paper (A3)* S041068

EPSON Photo Quality Ink Jet Paper 
(Super A3/Super B)*

S041069

EPSON Photo Quality Ink Jet Paper (B)* S041070

EPSON Photo Quality Ink Jet Cards (A6) S041054

EPSON Photo Quality Ink Jet Cards (5 × 8”) S041121

EPSON Photo Quality Ink Jet Cards (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheets (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 × 8” 
(with envelopes)

S041148

EPSON Ink Jet Greeting Cards 8 × 10” 
(with envelopes)

S041149
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Matte Paper-Heavyweight

Photo Paper

EPSON Matte Paper-Heavyweight (A4) S041256

EPSON Matte Paper-Heavyweight (B) S041266

EPSON Matte Paper-Heavyweight (A3)* S041260

EPSON Matte Paper-Heavyweight 
(Super A3/Super B)*

S041263

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (A3)* S041142

EPSON Photo Paper (Super A3/Super B)* S041143

EPSON Photo Paper (B)* S041156

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (4 × 6” No Perforations) S041458

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Photo Paper (89 mm × 7 M) S041281

EPSON Photo Paper (100 mm × 8 M) S041279

EPSON Photo Paper (210 mm × 10 M) S041280

EPSON Photo Paper (329 mm × 10 M)* S041233

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Photo Paper Cards (A4) S041177
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Photo Quality Glossy Film

Ink Jet Transparencies

Premium Glossy Photo Paper

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (A3)* S041073

EPSON Photo Quality Glossy Film (Super 
A3/Super B)*

S041074

EPSON Photo Quality Glossy Film (B)* S041075

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176

EPSON Ink Jet Transparencies (A4) S041063

EPSON Premium Glossy Photo Paper (A4) S041287

EPSON Premium Glossy Photo Paper (A3)* S041288

EPSON Premium Glossy Photo Paper (B)* S041290

EPSON Premium Glossy Photo Paper 
(Super A3/Super B)*

S041289

EPSON Premium Glossy Photo Paper 
(100mm × 8M)

S041302

EPSON Premium Glossy Photo Paper 
(210mm × 10M)

S041376

EPSON Premium Glossy Photo Paper 
(329mm × 7M)*

S041378
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Ink Jet Black Light Film

* Only with the EPSON Stylus Photo 1290.

Making the Mode setting

The Mode settings in the Print dialog box provide various setting 
options. The Print dialog box is shown below.

The Mode settings are explained below:

EPSON Ink Jet Back Light Film (A3)* S041131

Automatic This mode provides the quickest and easiest 
way to start printing. See “Using the 
Automatic mode” on page 5-8 for details.

PhotoEnhance This mode lets you choose from a variety of 
image-correction settings specially designed 
for photos. See “Using the PhotoEnhance 
mode” on page 5-9 for details.

Custom This mode lets you choose from a list of 
ready-made or personalized settings suited to 
the kind of document that you want to print. 
When Custom is selected, the Advanced 
button is enabled, allowing you to access the 
Advanced dialog box. See “Using the Custom 
mode” on page 5-10 for details.
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In addition to making comprehensive Mode settings that affect 
overall print quality, you can also modify individual aspects of 
your printout using the settings contained in the Page Setup and 
Layout dialog boxes. See “Making settings in the Page Setup 
dialog box” on page 5-19 or “Making settings in the Layout dialog 
box” on page 5-32 for details.

Refer to the appropriate section below.

Using the Automatic mode

When Automatic is selected as the Mode setting in the Print dialog 
box, the printer software takes care of all detailed settings based 
on the current Media Type and Ink settings. To make the Ink 
setting, see “Making the Ink setting” on page 5-14. To make the 
Media Type setting, see “Making the Media Type setting” on page 
5-3.

Note:
Depending on the media selected in the Media Type list (while 
Automatic is selected), a slider appears to the right of the Mode options 
that lets you choose from Quality and Speed settings. Select Quality 
when print quality is more important than speed.
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Using the PhotoEnhance mode

The PhotoEnhance mode provides a variety of image-correction 
settings that you can apply to your photos before printing. 
PhotoEnhance does not affect your original data.

Note:
❏ This mode is only available when printing 32-bit color data.

❏ Printing with PhotoEnhance selected may increase the time 
required for printing, depending on your computer system and the 
amount of data contained in your image.

❏ Do not print using the PhotoEnhance mode while Roll Paper is 
selected as the Paper Source setting in the Page Setup dialog box.

You can select from the following settings.

Standard This setting provides standard image correction for most 
photos. Try this first.

People This setting is best for photos of people.

Nature This setting is best for outdoor scenery such as mountains, 
sky, and oceans.

Soft Focus This setting makes your photos look as if they were taken 
with a soft-focus lens.

Sepia This setting applies a sepia tone to your photos.
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Selecting PhotoEnhance also enables the Digital Camera 
Correction check box. Select this check box when you are printing 
photos taken with a digital camera to give your printed images 
the smooth, natural appearance of photographs taken with a film 
camera.

Using the Custom mode

Selecting Custom as the Mode option enables the Custom Settings 
list, from which you can choose a ready-made setting designed 
for printing text and graphs. Or, you can select ColorSync, a color-
matching method. You can also create and save your own custom 
settings. For details on making your own custom settings see 
“Making the Advanced settings” on page 5-11.

By default, you can choose from the following:

When you select a custom setting, other settings such as Print 
Quality and Color Management are made automatically. Changes 
to these settings are reflected in the display at the left side of the 
Print dialog box.

Ready-made setting Description

Economy This setting is best for printing drafts of text.

Color-matching method

ColorSync This method automatically adjusts printout 
colors to match the colors on your screen.
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Follow the steps below to select a custom setting.

1. Confirm that the Media Type and Ink settings in the Print 
dialog box are correct. For details, see “Making the Ink 
setting” on page 5-14 or “Making the Media Type setting” on 
page 5-3.

2. Select Custom as the Mode setting in the Print dialog box. 
This enables the Custom Settings list, located to the right of 
the Custom radio button.

3. From the Custom Settings list, select the most appropriate 
setting for the type of document or image that you want to 
print.

Making the Advanced settings

The settings in the Advanced dialog box give you complete 
control over your printing environment. Use these settings to 
experiment with new printing ideas or to fine-tune a range of 
print settings to meet your individual needs. Once you are 
satisfied with your new settings, you can give them a name and 
add them to the Custom Settings list in the Print dialog box.

Follow the instructions below to make Advanced settings.
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1. Select Custom as the Mode setting in the Print dialog box and 
then click Advanced. The Advanced dialog box opens.

2. Select the Media Type that is loaded in the printer. For details, 
see “Making the Media Type setting” on page 5-3.

3. Choose Color or Black as the Ink setting.

4. Specify a Print Quality setting.

5. Make other settings as necessary. For details, see online help.

Note:
❏ The PhotoEnhance feature only affects images, not text or 

graphs. For example, if Monochrome is selected from the Tone 
list (enabled when PhotoEnhance is selected), only the 
images in a document will be printed in monochrome. Any 
colored text or graphs in the same document will be printed in 
color.

❏ Some settings may be unavailable, depending on the Media 
Type, Ink, and Print Quality settings that you make.
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6. Click OK to apply your settings and return to the Print dialog 
box. To return to the Main menu without applying your 
settings, click Cancel. To save your Advanced settings, 
proceed to the next section.

Saving and deleting your settings

To save your Advanced settings in the Custom Settings list, click 
Save Settings in the Advanced dialog box. The Custom Settings 
dialog box appears.

Type a unique name (up to 16 characters) for your settings in the 
Name text box, then click Save. Your Advanced settings will be 
added to the Custom Settings list. You can save up to 10 different 
custom settings.

Note:
❏ You cannot apply the names of EPSON ready-made settings or 

color-matching methods to your custom settings.

❏ You cannot delete the ready-made settings or color-matching 
methods from the Custom Settings list.

To delete a setting from the Custom Settings list, select it in the 
Custom Settings dialog box and click Delete.

Using your saved settings

To use your saved settings, select Custom as the Mode setting in 
the Print dialog box, then select your setting in the Custom 
Settings list, located to the right of the Custom radio button.
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If you change the Media Type or Ink settings while one of your 
customized settings is selected in the Custom Settings list, the 
selection shown in the list returns to Custom Settings. The 
customized setting that was previously selected is not affected by 
the change. To return to your customized setting, simply reselect 
it in the list.

Making the Copies setting

To make the Copies setting, enter the number of copies that you 
wish to print in the Copies text box.

Making the Pages setting

To make the Pages setting, select either All or Range. If you select 
Range, enter the appropriate range of pages in the Range text 
boxes.

Making the Ink setting

To make the Ink setting, click Color to print in color, or Black to 
print in black-and-white or grayscale.

Setting the print time

You can specify the time that you want the printer to begin 
printing your document. Follow the steps below.
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1. Click the  Background Printing icon button in the Print 
dialog box. The Background Printing dialog box opens.

2. Select On as the Background Printing option, if necessary.

3. Select Urgent, Normal, Print at, or Hold as the Print Time 
option.

If you select Print at, use the arrows beside the date and time 
boxes to specify the date and time that you want to print the 
document.

Note:
Make sure that the computer and printer are turned on at the date 
and time you specify.

4. Click OK. The Background Printing dialog box closes.

5. In the Print dialog box, make sure that your print settings are 
as you want them, then click Print.

Note:
You can check or change the priority of print jobs using the EPSON 
Monitor3 utility. See “Using EPSON Monitor3” on page 6-4 for details.
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Previewing your printout

The Preview feature allows you to see how your document will 
look before actually printing it. Follow these steps to preview 
your document.

1. Make your printer driver settings.

2. Click the  Preview icon button in the Print dialog box. The 
Print button changes into a Preview button. 

Note:
Use the  Preview icon button to toggle between the  Print, 

Preview, and Save File modes. Click the icon button to select 
the mode that you want. For information on the Save File mode, see 
“Saving spool data as a file” on page 5-18.

3. Click the Preview button. The Preview dialog box opens and 
displays a preview of your document.
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The Preview dialog box contains six icon buttons that you can 
use to perform the following functions.

Note:
❏ When using the double-sided printing feature, the Preview 

window allows you to toggle between pages in the print job by 
clicking the appropriate page in the list at the left side of the 
screen. The pages are listed in two columns, Front and Back. 
The pages in the Front column will print first. The page 
numbers listed refer to pages of the print job and may contain 
more than one document page.

❏ If it is necessary to reprint part of a double-sided print job, select 
each page of the print job that does not need to be reprinted in 
the list at the left side of the screen, then click the  remove 
page button. Make sure that the paper is loaded properly so that 
the print job will start on the correct side of the correct page.

Selection Click this button to select, move, and resize 
watermarks.

Zoom Click this button to enlarge or reduce the 
size of the previewed page.

Margin 
display/
non-
display

Click this button to display or hide the 
borderlines which indicate the printable 
area.

Watermark 
edit

Click this button to open the Watermark 
Edit dialog box, where you can add 
watermarks to the document and change 
any of the current watermark settings.

Add page Click these buttons to add or remove the 
highlighted pages from the list of pages to 
be printed.

Remove 
page
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4. If you are satisfied with the previewed image, click Print.

If you are not satisfied with the appearance of the image, click 
Cancel. The Preview and Print dialog boxes close with the 
current print settings preserved. Open the Print dialog box 
again to make additional changes to the print settings.

Saving spool data as a file

You can save spool data as a file using the  Save File icon button 
in the Print dialog box. This feature lets you use the saved spool 
data to print the document at a later time simply by double-
clicking the saved file. Follow the steps below.

Note:
Use the  Preview icon button to toggle between the  Print, 

Preview, and  Save File modes. Click the icon button to select the 
mode you want.

1. Make your printer driver settings.

2. Click the  Preview icon button in the Print dialog box 
repeatedly until the Print button changes into the Save File 
button.

3. Click the Save File button. The following dialog box appears.

4. Select the location where you want to save the file, then type 
a file name in the Save As text box and click Save.
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5. When you want to print the document, double-click the file 
to open EPSON Monitor3, make sure that the correct 
document is selected, then click the  Resume button to send 
the data to the printer.

Making settings in the Page Setup dialog box

In the Page Setup dialog box, you can change the paper size, 
specify the paper orientation, print on both sides of the paper, 
rotate your document by 180 degrees, reduce or enlarge your 
printout, and adjust the printable area.

Choose Page Setup from the File menu of your application. The 
Page Setup dialog box appears.
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You can make the following settings in the Page Setup dialog box.

Paper Size Select the paper size that you want to use. If you want 
to define a custom paper size, see “Defining a custom 
paper size” on page 5-23.

Paper Source Select the paper source you wish to use from the 
following selections.

Sheet Feeder:
Select this to leave a 3-mm margin on both the right and 
the left sides of the paper. This option is available when 
printing on normal paper.

Roll Paper:
Select this to leave a 3-mm margin on both the right and 
the left sides of the roll paper. 
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No Margins Check this box when you want to print with no margins.

Sheet Feeder :
Select this to leave no margins on full  side of the paper. 
This option is available only when printing with paper 
that is in the Paper size list. 

Roll Paper:
Select this to leave no margins on full side of the roll 
paper. This option is available only when printing with 
paper that is on the Paper size list.

You can use the following media with this feature. 

(Available paper sizes vary depending on your printer 
model.)

Photo Paper:
Super A3/ Super B*, A3*, Panoramic, A4, Letter, 4 x 6” 
(No Perforations), 100 x 150 mm

Matte Paper-Heavyweight:
Super A3 / Super B*, A3*, A4, Letter

Index Card:
5 x 8”

* only with the EPSON Stylus Photo 1290.

Note
If your application has margin settings, make sure they 
are set to zero before printing.

When using this feature with Roll Paper, you need to 
use your image-editing software to make the image 
4mm wider than the roll paper.

Printing with this feature selected takes longer than for 
normal printing.

Because this feature enlarges the image to a size 
slightly larger than the paper size when Sheet Feeder 
is selected as the Paper Source setting, the portion of 
the image that extends beyond the edges of the paper 
will not be printed.

Print quality may decline in the top and bottom areas of 
the printout, or the area may be smeared when printing 
on media other than that listed above. We recommend 
printing a single sheet to check quality before printing 
large jobs.

You cannot use this feature with the following media: 
Photo Quality Glossy Film, Ink Jet Transparencies, Iron-
On Cool Peel Transfer Paper, Ink Jet Back Light Film, 
360 dpi Ink Jet Paper.
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Orientation Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout. To print close to the bottom 
of the page, select the Rotate by 180 degrees check 
box.

Double-Sided 
Printing

Select the Double-Sided check box to print on both sides 
of the paper. Select the Folded Booklet check box to 
make single-fold booklets. For details, see “Making the 
Double-Sided Printing setting” on page 5-25.

Reduce or 
Enlarge

Use this setting to reduce or enlarge the size of your 
image from 25% to 400%.

Printable Area Use this option in the Printable Area Box to adjust the 
total area available for printing when sheet Feeder is 
selected as the Paper Source setting. This feature is not 
available when No Margins or Roll Paper is selected.

To center the printout, select Center. To increase the 
printable area at the bottom edge from 14mm to 3mm, 
select Maximum. Do not select Maximum while using 
Premium Glossy Photo Paper or Ink Jet Back Light Film 
(Stylus Photo 1290).

Note:
The print quality may decline at the edges of the printout 
when Maximum is selected as the Printable Area 
setting. Before printing large jobs using this setting, print 
a single sheet to confirm quality.
When Maximum is selected, make sure that the paper 
loaded in the sheet feeder is not curled.
If you select Maximum when printing on Premium 
Glossy Photo Paper, your printout may be smeared in 
the expanded area (between 14 mm and 3 mm from the 
bottom edge).
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Defining a custom paper size

You can define a custom paper size. To do so, you can either create 
a new paper size, or base your custom paper size on a pre-existing 
paper size. Refer to the appropriate section below.

Creating a new paper size

If the appropriate paper size is not included in the Paper Size list 
in the Page Setup dialog box, follow the steps below to define a 
new custom paper size.

Roll Paper 
Option

The Roll Paper Option settings are only available when 
Roll Paper is selected as the Paper Source setting. 
These features are not available when Sheet Feeder is 
selected.

The settings are as described below.

Banner Mode:
Select this mode when you want to print multi-page data 
as continuous data on the roll paper, rather than as 
individual pages. When this check box is selected, the 
Save roll paper check box is enabled.

Cut Sheet Mode:
Select this mode when you want to print multi-page data 
as individual pages, rather than as continuous data. 
When this check box is selected, the Print page frame 
check box is enabled.

Save roll paper:
Select this check box when you want to save roll paper. 
When this check box is selected, the blank portion of the 
last page of your document is not fed through the printer. 
This feature is only available when Banner Mode is 
selected.

Print page frame:
Select this check box to print a line on the roll paper 
between pages in a multi-page document to indicate 
where the paper should be cut. This feature is useful 
when it is unclear where the page breaks should be. This 
feature is only available when Cut Sheet Mode is 
selected.
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1. In the Page Setup dialog box, click Customize. The following 
dialog box appears.

2. To define a new paper size, click New. The dialog box updates 
to allow you to enter a name for the new size.

3. Type a unique name for the paper size in the Paper Size list.

4. Specify the measurement unit as either inch or cm.

5. Enter the width and the height of your paper by typing the 
text in the appropriate box.
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6. Specify the margins by typing in the Margin input boxes or 
by manipulating the preview image.

7. Click OK. You return to the Page Setup dialog box.

You can define up to 100 paper sizes. The paper size names you 
create will appear in the Paper Size list in the Page Setup dialog 
box.

To delete a custom paper size, click Customize in the Page Setup 
dialog box, select the paper size from the list in the Custom Paper 
dialog box, and click Delete.

Copying a pre-existing paper size to use as a template

Follow the steps below to copy an existing paper size to use as a 
template.

1. Select the existing paper size to copy and click Copy.

2. Specify the measurement unit as either inch or cm.

3. Specify the margins by typing in the Margin input boxes or 
by manipulating the preview image.

4. Click OK.

Making the Double-Sided Printing setting

There are two types of double-sided printing available. Standard 
double-sided printing allows you to print the odd-numbered 
pages first. Once these are printed, you can reload the printouts 
in the sheet feeder and print the even-numbered pages on the 
other side of the paper. Folded booklet double-sided printing 
allows you to make single-fold booklets. Refer to the appropriate 
section below.
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Note:
❏ The double-sided printing feature is not available when the printer 

is accessed over a network, or used as a shared printer.

❏ You can load up to 30 sheets of paper at one time when double-sided 
printing; however, the loading capacity of the sheet feeder varies, 
depending on the media type.

❏ Only use media types which are suitable for double-sided printing. 
Otherwise, the printout quality may deteriorate.

❏ Depending on the type of paper and the amount of ink used to print 
text and images, ink may bleed through to the other side of the paper.

Standard double-sided printing

Follow the steps below to print first the odd-numbered pages, and 
then the even-numbered pages after you have reloaded the 
printouts.

1. Select the Double-Sided Printing check box in the Page Setup 
dialog box. For information on accessing the Page Setup 
dialog box, see “Making settings in the Page Setup dialog 
box” on page 5-19.
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2. Click the Margins button. The following dialog box opens.

3. Specify which edge of the paper the binding will be on. You 
can choose between Left, Top, and Right.

4. Specify the width of the binding margin by entering a value 
in the Binding Margin text box. You can specify a value 
between 3 mm and 30 mm. 

Note:
The actual binding margin may vary, depending on your 
application. Experiment by printing a few sheets using different 
binding margin values before printing the entire job; otherwise, the 
results may differ from what you expect.

5. Click OK to return to the Page Setup dialog box, then click OK 
to save your settings.

6. Load paper in the sheet feeder, then send the print job from 
your application. While the printer is printing the odd-
numbered pages, instructions are displayed which explain 
how to reload the paper correctly.

7. Follow the instructions to reload the paper, or reload the 
paper as shown in the illustration below.

Note:
❏ The paper may curl during printing, depending on the amount 

of ink used to print text and images. Flatten it or curl it slightly 
toward the opposite side before printing on the other side of the 
paper.
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❏ Tap the stack of paper on a flat surface to align the edges before 
reloading it.

❏ Reload the printouts as instructed; otherwise, the paper may 
jam or the binding margin may differ from what you expect.

❏ If the paper jams, see “Cancelling Printing” on page 10-29.

8. Once the paper is reloaded, click Resume to print the even-
numbered pages.
5-28 Using the Printer Software for Macintosh



Folded booklet double-sided printing

You can also make single-fold booklets using the double-sided 
printing feature. When booklet printing, the printer first prints 
the pages which will be on the outside after you fold the paper 
and then prints the inside pages after you reload the paper, as 
shown in the illustration below.

In this example, the printer would print pages 1 and 4 of your 
document on the first sheet of paper, pages 5 and 8 on the second 
sheet of paper, and pages 9 and 12 on the third sheet of paper. 
After you reload the printouts in the sheet feeder, the printer 
would then print pages 2 and 3 on the back of the first sheet of 
paper, pages 6 and 7 on the back of the second sheet of paper, and 
10 and 11 on the back of the third sheet of paper. After printing is 
complete, you can fold each sheet of paper and then bind the 
pages together.

Follow the steps below to print booklets.

1. Select the Double Sided Printing check box in the Page Setup 
dialog box, then select the Folded Booklet check box.

2. Click the Margins button. The Margins dialog box opens.

Single-fold booklet

Binding Edge

1

2 4

3 5 9

6

7

8 10

11

12
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3. Specify which edge of the paper the binding will be on. You 
can choose between Left, Top, and Right.

Note:
While Portrait is selected as the Orientation setting in the printer 
driver, you can choose between Left and Right. While Landscape 
is selected, you can only select Top.

4. Specify the width of the binding margin by entering a value 
in the Binding Margin text box. You can specify a value 
between 3 mm and 30 mm. This margin width will be inserted 
on both sides of the fold. For example, if you specify a value 
of 10 mm, a 20-mm margin will be inserted, with 10 mm on 
each side of the fold.

5. Click OK to return to the Page Setup dialog box, then click OK 
to save your settings. 

6. Load paper in the sheet feeder, then send the print job from 
your application.

Margin

Folding 
Edge

Portrait Landscape
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7. While the printer is printing the outside pages, instructions 
are displayed which explain how to reload the paper 
correctly. Follow the on-screen instructions to reload the 
paper, or reload the paper as shown in the illustration in the 
previous section, “Standard double-sided printing” on page 
5-26.

Note:
❏ The paper may curl during printing, depending on the amount 

of ink used to print text and images. Flatten it or curl it slightly 
toward the opposite side before printing on the other side of the 
paper.

❏ Tap the stack of paper on a flat surface to align the edges before 
reloading it.

❏ Reload the printouts as instructed; otherwise, the paper may 
jam or the binding margin may differ from what you expect.

❏ If the paper jams, see “Cancelling Printing” on page 10-29.

8. Once the paper is reloaded, click Resume to print the inside 
pages. 

9. Once printing is complete, fold the printouts properly and 
bind them together using a stapler or other binding method.
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Making settings in the Layout dialog box

You can modify the page layout of your document using the 
printer driver settings located in the Layout dialog box. To open 
this dialog box, click Print on the File menu of your application, 
then click the  Layout icon button in the Print dialog box.

The Layout dialog box allows you to automatically match the 
document size to the paper size, print two or four pages on a single 
sheet of paper, print poster-size images by enlarging one page to 
cover several sheets, place watermarks on documents, or specify 
the printing order for your print job. Refer to the appropriate 
section below.

Making the Fit to Page setting

You can proportionally enlarge or reduce the size of the image to 
make it fit the paper size selected in the Paper Size list. To do this, 
select the Fit to Page check box, then specify the paper size that 
is loaded in the printer in the Paper Size list.
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Making the Watermark setting

To print a watermark on your document, select the Watermark 
check box in the Page Layout dialog box.

Select the watermark that you want to print from the Name list, 
then specify its position, size, color, and intensity. You can change 
the position and size of the watermark by dragging it with your 
mouse in the preview window at the left.

You can also add your own text-based or image-based 
watermarks to the Name list. Follow these steps.

1. Click the Add/Del button beside the Name list. The following 
dialog box appears.
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2. To use an image file as a watermark, click the Add PICT 
button. Specify the desired image file, then click Open.

To create a text-based watermark, click the Add Text button. 
Type the text in the Text box, select a font and a text style, then 
click OK.
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3. The image file name or the watermark text appears in the 
Mark Name list in the Watermark dialog box. To change the 
name of an image watermark, click it in the list, then type a 
new name. When a text watermark is selected in the Name 
list, you can edit the text or change the font and text style by 
clicking the Edit Text button.

4. Click OK to add your watermark to the Name list in the Page 
Layout dialog box.
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Making the Multi-Page setting

Selecting the Multi-Page check box allows you to choose between 
the N-up and Poster settings. Refer to the appropriate section 
below.

Making the N-up setting

Select N-up as the Multi-Page setting in the Layout dialog box to 
print two or four pages of your document on one sheet of paper.

To print more than one page on a piece of paper, you should make 
the following settings:

2 Pages
4 Pages

Prints two or four pages of your document on a 
single piece of paper.

Page Order Allows you to specify the order in which the pages 
will be printed on the sheet of paper.

Print page 
frames

Prints a frame around each page that is printed on 
the sheet of paper.
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Making the Poster setting

A single document page can be enlarged to cover 4, 9, or 16 
printed sheets of paper. Select Poster as the Multi-Page setting to 
print a poster-size image.

You can make the following settings

1 page covers xx 
sheets

Specifies how many printed sheets of paper the 
enlarged document page is to cover. You can select 4, 
9, or 16 pages.

Overlapping 
Alignment Marks

Slightly overlaps the images and prints alignment 
markers so that they can be aligned more precisely.

Trim Lines Prints border lines on the images to guide you when 
trimming the pages.

Panel Selection Click the panels you do not need to print, then click the 
OK button to print the remaining panels.
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How to make a poster from your printouts

Here is an example of how to make a poster from 4 sheets of your 
printout. Refer to the accompanying illustrations as well.

1. Vertically cut the margin of Sheet 1 along the line connecting 
the alignment markers as shown in the illustration.
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2. Place Sheet 1 on Sheet 2 and align the cross markers on both 
sheets, then temporary tape them from the back side of the 
paper. 

3. Cut off the taped sheets along the line between the alignment 
markers.

4. Align the paper using the alignment markers and tape them 
from the back side of the paper.

5. Repeat the instructions from step 1 to step 4 to tape Sheets 3 
and 4 as well.
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6. Repeat the instructions from step 1 to step 4 to tape top and 
bottom faces of the paper.

7. Cut off the remaining margins.

c
Caution:
Be careful when using edged tools.

If you only want to print a few of the panels without printing the 
entire poster, click Panel Selection, then click the panels that you 
do not wish to print, and then click OK. Only the panels that you 
did not click will be printed.

Making the Print Order setting

You can specify the printing order for your print job. When 
printing multiple copies of your document, select Collate to print 
one complete document set at a time. Select Reverse Order to 
print your documents in reverse order, starting with the last page.
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Using the Printer Utilities

EPSON printer utilities allow you to check the current printer 
status and to perform printer maintenance from your computer.

To use the utilities, click the  Utility icon button in the Print or 
Page Setup dialog box, then click the button for the utility that 
you want to use.

Note:
Do not use the Nozzle Check, Head Cleaning, or Print Head Alignment 
utilities while printing is in progress; otherwise, your printout may be 
marred.

Refer to the appropriate section below.

EPSON StatusMonitor

The StatusMonitor utility monitors the printer status. If it detects 
a printer error, it will inform you with an error message.

You can also use this utility to check how much ink is remaining 
before printing.
Using the Printer Software for Macintosh 5-41



To use the StatusMonitor, click the EPSON StatusMonitor button 
in the Utility dialog box. For details, see “Using EPSON 
StatusMonitor” on page 6-1.

Nozzle Check

The Nozzle Check utility checks the print head nozzles for 
clogging. Check the nozzles if you notice print quality has 
declined and after cleaning to confirm that the print head nozzles 
have been cleared. If the nozzle check indicates the print head 
needs cleaning, you can access the Head Cleaning utility directly 
from the Nozzle Check utility. For details, see “Checking the Print 
Head Nozzles” on page 9-1.

Head Cleaning

The Head Cleaning utility cleans the print head. You may need 
to clean the print head if you notice print quality has declined. 
Use the Nozzle Check utility first to confirm that the print head 
needs to be cleaned. For details, see “Cleaning the Print Head” on 
page 9-3.

Print Head Alignment

The Print Head Alignment utility aligns the print head. Use this 
utility if you notice a misalignment of vertical or horizontal lines. 
Follow the on-screen instructions to use this utility.

Configuration

Click this button to open the Configuration dialog box, where you 
can change the method by which the StatusMonitor utility notifies 
you when the printer status changes. For details, see “Using the 
Configuration Settings dialog box” on page 6-2.
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Getting Information Through Online Help

Your printer software has an extensive online help feature, which 
provides you with instructions on printing, making printer driver 
settings, and using the printer utilities.

To access online help, choose Print or Page Setup from the File 
menu of your application. Then, click the  Help icon button.
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Chapter 6

Checking Printer Status and Managing 
Print Jobs for Macintosh

Using EPSON StatusMonitor

EPSON StatusMonitor monitors the printer. If it detects a printer 
error, it will inform you with an error message.

When the ink runs low or out, a How to button appears. Click 
How to and EPSON StatusMonitor will lead you step-by-step 
through the ink cartridge replacement procedure.

You can also use this utility to check ink levels before printing. 
When open, EPSON StatusMonitor displays the amount of ink 
remaining at the time it was opened. To update the ink level 
information, click the Update button.
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Accessing EPSON StatusMonitor

Follow the steps below to access EPSON StatusMonitor.

1. Click Print or Page Setup on the File menu of your 
application. The Print dialog box opens.

2. Click the  StatusMonitor icon button or click the  Utility 
icon button and then the EPSON StatusMonitor button in 
the Utility dialog box. The StatusMonitor dialog box opens.

Note:
When you install a Light Capacity ink cartridge, the Ink Level 
display will show that the cartridge is only half full. This is because 
a Light Capacity ink cartridge only contains half as much ink as a 
regular cartridge.

Using the Configuration Settings dialog box

To change the way that the StatusMonitor utility monitors your 
printer, or to change the way that your printer handles print jobs, 
follow the steps below.
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1. Click Print or Page Setup on the File menu of your 
application.

2. Click the  Utility icon button.

3. Click the Configuration button. The Configuration Settings 
dialog box appears.

In the Configuration Settings dialog box, you can make the 
following settings:

Error notification Choose the method by which EPSON 
StatusMonitor will notify you in case of an 
error.

Warning Choose the method by which EPSON 
StatusMonitor will notify you if a warning 
message becomes necessary.

Temporary Spool 
folder

Specify the folder in which print data will be 
temporarily spooled.

Temporary High Speed 
Copies folder

Specify the folder in which multiple-copy print 
data will be temporarily stored.
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Using EPSON Monitor3

After you send a print job to the printer, you can use the EPSON 
Monitor3 utility to check, cancel, or change the priority of print 
jobs that are queued for printing. This utility also shows the status 
of the job currently being printed.

Accessing EPSON Monitor3

To access EPSON Monitor3, follow these steps.

1. First, turn on Background Printing in the Chooser or in the 
Background Printing dialog box.

2. Send a print job to the printer.

Data will be sent to the 
printer after being 
stored on your disk.

Select this check box to prevent horizontal 
banding in printouts that contain images by 
having the computer temporarily store image 
data on its hard drive. The computer will then 
send the image data to the printer as a whole 
rather than as rectangular bands.

Check for errors before 
starting to print.

Select this check box to have the printer check 
for errors before starting to print.

Check the ink level 
before starting to print.

Select this check box to have the printer check 
the ink levels before starting to print.
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3. Select EPSON Monitor3 from the Application menu at the 
right end of the menu bar. The EPSON Monitor3 dialog box 
opens.

Note:
You can also open EPSON Monitor3 by double-clicking the EPSON 
Monitor3 icon in the Extensions folder.

Managing print jobs using EPSON Monitor3

Using EPSON Monitor3, you can manage print jobs as described 
below:

❏ Use the buttons below to hold, resume, and delete print jobs. 
Select the print job that you want to manage, then click the 
appropriate button.

❏ Click Stop Print Queue to stop printing. Click Start Print 
Queue to resume printing.

Hold Pauses printing and keeps the current print 
job at the top of the print queue

Resume Resumes printing

Delete Stops printing and deletes the print job from 
the print queue
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❏ Use the buttons below to start the printer utilities.

❏ Double-click a file in the list to preview it (this function is 
disabled when you are printing the ESC/P command file).

❏ Double-click Copies to change the number of copies of the 
selected print job that will be printed.

❏ Click the Show details arrow to open an extension at the 
bottom of the EPSON Monitor3 dialog box similar to the one 
below. The extension displays detailed information on the 
selected document’s printer software settings.

Print head 
cleaning

Starts the Print Head Cleaning utility

StatusMonitor Starts EPSON StatusMonitor, which 
displays the amount of ink remaining
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Changing the priority of print jobs

To change the priority of print jobs in a print queue, follow the 
steps in this section.

Note:
You can also change the priority of print jobs whose print times were 
previously set in the printer software’s Background Printing dialog box.

1. In the Document Name column, select the print job for which 
you want to change the priority.

2. Click the Show details arrow to open an extension at the 
bottom of the EPSON Monitor3 dialog box, similar to the one 
below.

3. From the Priority list, select Urgent, Normal, Hold, or Print 
Time.

Note:
If you select Print Time, a dialog box opens where you can specify 
the date and time that the document will print. Make sure that your 
printer and computer are turned on at the specified time.
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Chapter 7

Setting Up Your Printer on a Network

For Windows Me, 98 and 95 Users

This section tells you how to set up your printer so that other 
computers on a network can use it.

First, you need to set up the printer as a shared printer on the 
computer to which the printer is connected. Then, you must 
specify the network path to the printer from each computer that 
will use it and install the printer software on those computers.

Note:
This section describes how to use your printer as a shared printer on a 
network. To connect your printer directly to a network without setting 
it up as a shared printer, consult your network administrator.

Setting up your printer as a shared printer

To share a printer with other computers on a network, follow the 
steps below to configure to computer to which the printer is 
connected.

1. Click Start, point to Settings, then click Control Panel.

2. Double-click the Network icon.

3. Click the File and Print Sharing button.
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4. Select the I want to be able to allow others to print to my 
printer(s) check box and click OK.

5. In the Network dialog box, click OK.

6. In the Control Panel, double-click the Printers icon.

Note:
❏ If a dialog box requesting the insertion of the Windows 98 or 95 

CD-ROM appears, insert the CD-ROM in the CD-ROM drive 
and follow the on-screen instructions.

❏ If a dialog box requesting you to restart your computer appears, 
do so. Then, open the Printers folder, and continue from step 7.

7. Select the icon for your printer in the Printers folder, then click 
Sharing on the File menu.
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8. Select Shared As, then type the printer information as 
required and click OK.

Accessing the printer through a network

To access your printer from other computers on a network, follow 
the steps below for each computer that will access the printer.

Note:
Your printer must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another 
computer. For instructions, see “Setting up your printer as a shared 
printer” on page 7-1.

1. Click Start, point to Settings, and click Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard 
opens. 

3. Click Next.
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4. Select Network printer, then click Next.

5. Click Browse.

6. Double-click the icon of the computer that is directly 
connected to the printer. Then, click the icon for the 
appropriate printer.

7. Click OK and follow the on-screen instructions.
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For Windows 2000 and NT 4.0 Users

This section tells you how to set up your printer so that other 
computers on the network can use it.

Note:
❏ This section is written for small network users only. If you are on a 

large network and would like to share your printer, consult your 
network administrator.

❏ The screens shown in this section are from Windows NT 4.0.

First, you need to set up the printer as a shared printer on the 
computer to which the printer is connected. Then, you must 
specify the network path to the printer from each computer that 
will use it and install the printer software on those computers.

Setting up your printer as a shared printer

To share a printer with other computers on a network, follow the 
steps below to configure the computer to which the printer is 
connected.

1. Click Start, point to Settings, and click Printers.

2. Select the icon for your printer, then click Sharing on the File 
menu.
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3. Click Shared (for Windows 2000 users, select Shared as), 
then type the Share Name.

4. Click OK.

Note:
For Windows NT 4.0 users, do not select a driver from the Alternate 
Drivers list. For Windows 2000 users, do not select a driver from 
Additional Drivers list in the Additional Drivers dialog box.

Accessing the printer through a network

To access your printer from other computers on the network, 
follow the steps in this section for each computer that will access 
the printer.

Note:
Your printer must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another 
computer. For instructions, see “Setting up your printer as a shared 
printer” on page 7-5.

1. Install the printer software from the software CD-ROM.
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2. Click Start, point to Settings, and then click Control Panel.

3. Double-click the Printers icon.

4. Right-click the icon for your printer, then click Properties on 
the shortcut menu that appears. The printer software opens.

5. Click the Ports tab, then click Add Port.
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6. In the Printer Ports dialog box, select Local Port, then click 
New Port.

7. In the Port Name dialog box, enter the path information for 
your printer using the format below:
\\name of computer that is connected to the printer\name 
of the shared printer.

8. Click OK to return to the Printer Ports dialog box.

9. Click Close to return to the Ports menu.
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10. On the Ports menu, make sure that the new port is included 
in the list and that the corresponding check box is selected. 
Click OK to close the printer software.

For Macintosh Users

This section tells you how to set up the printer so that you can use 
it on an AppleTalk network. By setting up your printer as a shared 
printer, your local printer is connected to the network and can be 
used by other computers.

First, you need to set up the printer as a shared printer on the 
computer to which the printer is connected. Then, you must 
specify the network path to the printer from each computer that 
will use it, and install the printer software on those computers.

Setting up your printer as a shared printer

To share a printer with other computers on an AppleTalk 
network, follow the steps below to configure the computer to 
which the printer is connected.
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1. Turn on the printer.

2. Choose Chooser from the Apple menu and click the icon for 
your printer. Then, select the port to which the printer is 
connected.

3. Click the Setup button. The Printer Sharing Setup dialog box 
opens.

4. Select the Share this Printer check box, then type the printer 
name and password information as necessary.

5. Click OK. The name of the shared printer appears in the port 
list in the Chooser.

6. Close the Chooser.
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Accessing the printer through a network

To access your printer from other computers on a network, follow 
the steps in this section for each computer that will access the 
printer.

1. Turn on your printer.

2. Install the printer software from the printer software 
CD-ROM.

3. Choose Chooser from the Apple menu. Then, click the 
appropriate printer icon and select the printer port that you 
want to use from the Select a printer port list.

Note:
Only printers that are connected to your current AppleTalk zone 
are available.
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If the following dialog box appears, enter the password for 
the printer, then click OK.

4. Select the appropriate Background Printing radio button to 
turn background printing on or off.

5. Close the Chooser.
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Chapter 8

Replacing Ink Cartridges

Using the Printer’s Control Panel

This printer uses ink cartridges equipped with IC chips. The IC 
chip accurately monitors the amount of ink used by each 
cartridge, so even if a cartridge is removed and later inserted 
again, all of its ink can be used. However, some ink is consumed 
each time the cartridge is inserted because the printer 
automatically checks reliability.

You can replace an ink cartridge using the printer’s control panel 
or using the Status Monitor utility. To replace an ink cartridge 
using the e ink cartridge replacement button on the printer’s 
control panel, follow the steps below. To replace an ink cartridge 
or check ink levels using the Status Monitor utility, refer to “Using 
the Status Monitor” on page 8-7.

w
Warning:
❏ Keep ink cartridges out of the reach of children. Do not allow 

children to drink from or otherwise handle the cartridges.

❏ Be careful when you handle the used ink cartridges, as there 
may be some ink around the ink supply port. If ink gets on 
your skin, wash the area thoroughly with soap and water. If 
ink gets into your eyes, flush them immediately with water. 
If discomfort or vision problems remain after a thorough 
flushing, see a physician immediately.
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c
Caution:
❏ EPSON recommends the use of genuine EPSON ink 

cartridges. Other products not manufactured by EPSON 
may cause damage to your printer not covered by EPSON’s 
warranties.

❏ Leave the old cartridge installed in the printer until you have 
obtained a replacement; otherwise, ink remaining in the print 
head nozzles may dry out.

❏ Do not refill the ink cartridges. The printer calculates the 
amount of ink remaining using an IC chip on the ink 
cartridge. Even if the cartridge is refilled, the amount of ink 
remaining will not be recalculated by the IC chip and the 
amount of ink available for use will not change.

Note:
❏ You cannot continue printing with one ink cartridge empty, even if 

the other cartridge still contains ink. Before printing, replace the 
empty cartridge.

❏ In addition to the ink used during document printing, ink is 
consumed during the print head cleaning operation, during the self-
cleaning cycle which is performed when the printer is turned on, 
and during ink charging when the ink cartridge is installed in the 
printer.

For more information about ink cartridges, see “When handling 
the ink cartridges” on page 7.

1. Make sure that the printer is on, but not printing. Then, open 
the printer cover.

Note:
You can identify the status of the printer condition. When the error 
light is flashing, black or color ink cartridge is low. When the error 
light is on, black or color ink cartirdge is empty.
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2. Press down the e ink cartridge replacement button. The print 
head moves left to the Ink cartridge replacement position. The 
P power light begins to flash, and the error light begins to 
flash or remains on. To discover which cartridge requires 
replacing, refer to the table below, or check EPSON Status 
Monitor 3 (for Windows) or EPSON StatusMonitor (for 
Macintosh).

O = on, N = off, F = flashing

c
Caution:
Do not move the print head by hand, as this may damage the 
printer. Always press the e ink cartridge replacement 
button to move it.

Lights Action

F b Replace the black ink cartridge if the b error light flashes 
at the same speed as the power light.

F b Replace the color ink cartridge if the b error light flashes 
at twice the speed of the P power light.

O b Replace both the black and color ink cartridges if this light 
remains on.
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3. Lift up the ink cartridge clamp as far as it will go. Take the 
cartridge out of the printer. If the cartridge is empty, dispose 
of it properly. Do not take the used cartridge apart or try to 
refill it.

w
Warning:
If ink gets on your hands, wash them thoroughly with soap 
and water. If ink gets into your eyes, flush them immediately 
with water. If discomfort or vision problems remain after a 
thorough flushing, see a physician immediately.

4. Remove the new ink cartridge from its protective bag and 
then only peel off the yellow tape seal. Do not touch the green 
chip on the side of the cartridge. 

black ink cartridge (T007) color ink cartridge
Stylus Photo 1290 (T009)
Stylus Photo 890 (T008)
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c
Caution:
❏ You must remove the yellow tape seal from the cartridge 

before installing it; otherwise, the cartridge will become 
unusable and you will be unable to print.

❏ If you have installed an ink cartridge without removing 
the yellow tape seal, you must remove the cartridge and 
install a new one. Prepare the new cartridge by removing 
the yellow tape seal, then install it in the printer.

❏ Do not remove the blue portion of the tape seal from the 
top of the cartridge; otherwise, the print head may 
become clogged and be unable to print.

❏ Do not remove the tape seal from the bottom of the 
cartridge; otherwise, ink will leak.

❏ Do not remove the green IC chip from the side of the 
cartridge. If you install an ink cartridge without an IC 
chip, the printer may be damaged.

❏ Do not touch the green IC chip on the side of the 
cartridge; otherwise, normal operation and printing 
may not be possible.

5. Align the tabs on the ink cartridge so that they are resting on 
the tabs protruding from the base of the opened ink cartridge 
clamp. Push the clamps down until they lock firmly into place.

Do not touch this part.
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c
Caution:
❏ Make sure that the ink cartridge tabs are not under the 

hinges protruding from the base of the opened ink 
cartridge clamp, as this could damage the clamp.

❏ After you remove an ink cartridge from the printer, 
please insert a new one immediately. If no cartridge is 
present, the print head may dry out and become unable 
to print.

6. Press the e ink cartridge replacement button. The printer 
moves the print head and begins charging the ink delivery 
system. This process takes about one minute to complete. 
When the ink charging process is finished, the printer returns 
the print head to its home position, the P power light stops 
flashing and remains on and the b error light goes out.
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c
Caution: 
The P power light continues to flash while the printer is 
charging ink. Never turn off the printer while this light is 
flashing. Doing so can result in incomplete charging of ink.

7. Close the printer cover.

Using the Status Monitor 

You can monitor the remaining ink levels from your computer 
and view on-screen instructions for replacing a low or empty ink 
cartridge using EPSON Status Monitor 3 (for Windows 98, 95, 
2000, and NT 4.0) or EPSON StatusMonitor (for Macintosh).

When an ink cartridge is low or empty, click the How to button 
in the EPSON Status Monitor window. Follow the on-screen 
instructions to replace the cartridge.

For more information on using EPSON Status Monitor, see 
“Using EPSON Status Monitor 3” on page 4-4 for Windows, or 
“Using EPSON StatusMonitor” on page 6-1 for Macintosh.
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Chapter 9

Maintenance

Checking the Print Head Nozzles

If you find that the printed image is unexpectedly faint or dots in 
the printed image are missing, you may be able to identify the 
problem by checking the print head nozzles.

You can check the print head nozzles from your computer using 
the Nozzle Check utility in the printer software, or from the 
printer itself by using the printer’s control panel buttons.

Using the Nozzle Check utility

Refer to the appropriate section below to use the Nozzle Check 
utility.

Note:
Do not use the Nozzle Check utility while printing is in progress; 
otherwise, your printout may be marred.

For Windows users

Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 size paper is loaded in the sheet feeder.

2. Access the printer software. If you need instructions, see 
“Accessing the printer software” on page 3-2.

3. Click the Utility tab, then click the Nozzle Check button.

4. Follow the on-screen instructions.
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For Macintosh users

Follow the steps below to use the Nozzle Check utility.

1. Access the Print or Page Setup dialog box and click the 
Utility icon button, then click the Nozzle Check button in 

the Utility dialog box.

2. Follow the on-screen instructions.

Using the control panel buttons

Follow the steps below to check the print head nozzles using the 
control panel buttons.

1. Turn off your printer.

2. Make sure that A4 size paper is loaded in the sheet feeder.

3. Hold down the b maintenance button (➀ in the illustration 
below) and press the P power button (➁ in the illustration 
below) to turn on the printer.

4. Release only the P power button first. When the nozzle check 
starts, release the b maintenance button.
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The printer prints an operation check page that includes your 
printer’s ROM version information, the ink counter code, and a 
nozzle check pattern. Below are sample printouts.

Good sample

Print head needs to be cleaned

The above sample may be shown in black and white, but the actual test prints 
in color (CMYK).

If the nozzle check page does not print satisfactorily (for example, 
if any segment of the printed lines is missing), there is a problem 
with the printer. This could be a clogged ink nozzle or a 
misaligned print head. See the next section for details on cleaning 
the print head. For information on aligning the print head, see 
“Aligning the Print Head” on page 9-8.

Cleaning the Print Head

If you find that the printed image is unexpectedly faint or dots in 
the printed image are missing, you may be able to solve these 
problems by cleaning the print head, which ensures that the 
nozzles are delivering ink properly.

You can clean the print head from your computer using the Head 
Cleaning utility in the printer software, or from the printer itself 
by using the printer’s control panel buttons.

Segments are missing
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Note:
❏ Print head cleaning uses both color and black ink. To avoid wasting 

ink, clean the print head only if print quality declines; for example, 
if the printout is blurry or the color is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head 
needs to be cleaned. This saves ink.

❏ When the b error light is flashing or on, you cannot clean the print 
head. Replace the appropriate ink cartridge first.

❏ Do not start the Head Cleaning or Nozzle Check utility while 
printing is in progress; otherwise, your printout may be marred.

Using the Head Cleaning utility

Refer to the appropriate section below to use the Head Cleaning 
utility.

For Windows users

Follow the steps below to clean the print head using the Head 
Cleaning utility.

1. Make sure that the printer is on and the b error light is off.

Note:
If the b error light is flashing, you cannot clean the print head. 
Replace the appropriate ink cartridge first.

2. Access the printer software. For instructions, see “Accessing 
the printer software” on page 3-2.

3. Click the Utility tab, then click the Head Cleaning button.

4. Follow the on-screen instructions.

The P power light flashes while the printer performs the 
cleaning cycle. It takes about thirty seconds to complete.
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c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

5. When the P power light stops flashing, click Print nozzle 
check pattern in the Head Cleaning dialog box to confirm 
that the head is clean and to reset the cleaning cycle.

Below are nozzle check patterns:

Good sample

Print head needs to be cleaned

The above sample may be shown in black and white, but the actual check 
pattern prints in color.

In the check pattern, if you find that any segments are missing 
from the test lines, you may need to repeat the head cleaning and 
print the nozzle check pattern again.

If print quality hasn’t improved after repeating this procedure 
four or five times, turn the printer off and leave it alone overnight. 
Then do the head cleaning again.

If the print quality still has not improved, one or both of your ink 
cartridges may be old or damaged and may need to be replaced. 
See “Replacing Ink Cartridges” on page 8-1.

If print quality remains a problem after replacing the ink 
cartridges, contact your dealer.

Segments are missing
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Note:
To maintain print quality, we recommend turning on the printer for at 
least one minute every month.

For Macintosh users

Follow the steps below to clean the print head using the Head 
Cleaning utility.

1. Make sure that the printer is on and the b error light is off.

2. Access the printer software and click the Utility icon 
button, then click the Head Cleaning button.

3. Follow the on-screen instructions.

The P power light flashes while the printer performs the 
cleaning cycle. This operation takes about thirty seconds to 
complete.

c
Caution:
Never turn off the printer while P power light is flashing. 
Doing so may damage the printer.

4. When the P power light stops flashing, click the 
Confirmation button in the Head Cleaning dialog box to print 
a nozzle check pattern and to reset the cleaning cycle. Use the 
check pattern to confirm that the head is clean. Refer to 
page 148 to see a sample of the nozzle check pattern.

If print quality has not improved after repeating this procedure 
four or five times, turn the printer off and leave it alone overnight. 
Then, do the head cleaning again.

If the print quality still has not improved, one or both of your ink 
cartridges may be old or damaged and may need to be replaced. 
See “Replacing Ink Cartridges” on page 8-1.

If print quality remains a problem after replacing the ink 
cartridges, contact your dealer.
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Note:
To maintain print quality, we recommend turning on the printer for at 
least one minute every month.

Using the control panel buttons

Follow the steps below to clean the print head using the control 
panel buttons.

1. Make sure that the P power light is on and that the b error 
light is off.

Note:
If the b error light is flashing or on, you cannot clean the head and 
this operation will start the ink cartridge replacement procedure. If 
you do not want to replace an ink cartridge at this moment, press 
the b maintenance button to return the print head to its home 
position.

2. Hold down the b maintenance button for three seconds.

The printer starts cleaning the print head and the P power 
light begins flashing. Print head cleaning takes about thirty 
seconds to complete.

c
Caution:
Never turn off the printer while theP power light is flashing. 
Doing so may damage the printer.
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3. When the P power light stops flashing, print a nozzle check 
pattern to confirm that the head is clean and to reset the 
cleaning cycle.

If print quality has not improved after repeating this procedure 
four or five times, turn the printer off and leave it alone overnight. 
Then, do the head cleaning again.

If the print quality still has not improved, one or both of your ink 
cartridges may be old or damaged and may need to be replaced. 
See “Replacing Ink Cartridges” on page 8-1.

If print quality remains a problem after replacing the ink 
cartridges, contact your dealer.

Note:
To maintain print quality, we recommend turning on the printer for at 
least one minute every month.

Aligning the Print Head

If you notice a misalignment of vertical lines, you may be able to 
solve this problem from your computer using the Print Head 
Alignment utility in your printer software. Refer to the 
appropriate section below.

Note:
Do not start the Print Head Alignment utility while printing is in 
progress; otherwise, your printout may be marred.

For Windows users

Follow the steps below to align the print head using the Print 
Head Alignment utility.
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1. Make sure that A4 size plain paper is loaded in the sheet 
feeder.

2. Access the printer software. For instructions, see “Accessing 
the printer software” on page 3-2.

3. Click the Utility tab, then click the Print Head Alignment 
button.

4. Follow the on-screen instructions to align the print head.

For Macintosh users

Follow the steps below to align the print head using the Print 
Head Alignment utility.

1. Make sure that A4 size plain paper is loaded in the sheet 
feeder.

2. Access the printer software and click the Utility icon 
button, then click the Print Head Alignment button.

3. Follow the on-screen instructions to align the print head.

Cleaning the Printer

To keep your printer operating at its best, clean it thoroughly 
several times a year as follows.

1. Unplug the printer’s power cord.

2. Remove any paper from the sheet feeder.

3. Use a soft brush to carefully clean away all dust and dirt from 
the sheet feeder.
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4. If the outer case or the inside of the sheet feeder is dirty, clean 
it with a soft, clean cloth dampened with mild detergent. Keep 
the printer cover closed to prevent water getting inside.

5. If the inside of the printer accidentally gets soiled with ink, 
wipe it off with a damp cloth.

w
Warning:
Be careful not to touch the gears or rollers inside the printer.

c
Caution:
❏ Be careful not to wipe grease on the metal parts under the 

ink carriage passage.

❏ Never use alcohols or thinners to clean the printer; these 
chemicals can damage the components as well as the case.

❏ Be careful not to get water on the printer mechanism or 
electronic components.

❏ Do not use a hard or abrasive brush.

❏ Do not spray the inside of the printer with lubricants. 
Unsuitable oils can damage the mechanism. Contact your 
dealer or a qualified service person if lubrication is needed.

Transporting the Printer

If you need to transport your printer, carefully prepare and repack 
it as described below using the original box (or a similar box that 
the printer fits snugly into) and packing materials. Follow the 
steps below.

1. Open the printer cover and make sure that the print head is 
in the home (far right) position. If not, plug in the printer and 
wait until the print head returns to the home position. Then, 
close the printer cover and unplug the printer.
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c
Caution:
Leave the ink cartridges installed when you transport the 
printer. Removing the cartridges during transport can 
damage the printer.

2. Disconnect the interface cable from the printer.

3. Remove the paper from the sheet feeder and remove the paper 
support.

4. Open the printer cover again. Secure the ink cartridge holder 
to the printer with tape as shown below, then close the printer 
cover.

5. Raise the output tray.

6. Attach the protective materials to both sides of the printer.

7. Repack the printer and power cord in the original box.

8. Keep the printer level during transport.

Updating and Uninstalling software

Follow the directions in this section if you have updated your 
computer, want to update your printer software from a previous 
version, or need to uninstall the printer driver.
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Updating to Windows 98

If you have upgraded your computer’s operating system from 
Windows 95 to Windows 98, you must uninstall your printer 
software and then install it again. Uninstall the printer software 
by double-clicking the Add/Remove Programs icon in the 
Windows Control Panel and selecting EPSON Printer Software 
from the list. Click the Add/Remove button. The EPSON Printer 
Software Uninstall dialog box appears. Select the printer model 
and click OK. Then, install the printer software again.

Updating to Windows Me

If you are using parallel cable connection and you have upgraded 
your computer’s operating system from Windows 98 or 95 to 
Windows Me, you must uninstall your printer software and then 
install it again. Uninstall the printer software by double-clicking 
the Add/Remove Programs icon in the Windows Control Panel 
and selecting EPSON Printer Software from the list. Click the 
Add/Remove button. The EPSON Printer Software Uninstall 
dialog box appears. Select the printer model and click OK. Then, 
install the printer software again.
9-12 Maintenance



Updating the printer software in Windows 2000 
and NT 4.0

When you update the printer software in Windows 2000 and 
NT 4.0, please be sure to uninstall the previous printer software 
before you install the new software. Installing over the existing 
printer software results in a failure to update. To uninstall the 
printer software, double-click the Add/Remove Programs icon 
in the Windows Control Panel. The Add/Remove Programs 
Properties dialog box appears. Select EPSON Printer Software 
from the list and click Change/Remove (Windows 2000) or 
Add/Remove (Windows NT 4.0). The EPSON Printer Software 
Uninstall dialog box appears. Select the printer model and click 
OK.

Uninstalling the printer driver

For Windows

1. Turn off the printer and disconnect the cable from the printer.

2. Click the Start button and select Settings, then choose 
Control Panel.

3. Double-click the Add/ Remove Program icon and select 
EPSON Printer Software from the list. Click the Add/Remove 
button.

4. Select the Stylus Photo 1290 or 890 icon and click OK.

5. Select OK.
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Note:
If you are a Windows 98 user and using USB port, you also need to 
uninstall the USB printer. First, you must uninstall the EPSON USB 
printer and EPSON Status Monitor3. Then follow steps 1 and 2 above, 
and select EPSON USB printer device from the list. Click the Add/ 
Remove button and click OK when the message telling you to reboot the 
computer is displayed.  

For Macintosh

1. Turn on your Macintosh and insert the software CD in the 
CD-ROM drive. The EPSON printer software disk will open 
automatically.

2. If a single Installer icon appears, double-click the icon. If 
separate folders containing installer icons for several 
languages appear, double-click the folder for your preferred 
language, then double-click the Installer icon inside it.

3. After the initial screen, click Continue. The following dialog 
box will appear.

4. Select Uninstall from the pull-down menu at the top left.

5. Click Uninstall.
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Chapter 10

Troubleshooting

Diagnosing the Problem

If you are connecting via the USB interface and are having 
difficulty printing, the problem may be related to your USB 
connection. Refer to “Correcting USB Problems” on page 10-23 
for details. 

If your problem is not USB related, troubleshooting printer 
problems is best handled in two easy steps: first diagnose the 
problem, then apply likely solutions until the problem is fixed. 

The information that you need to diagnose and solve most 
common problems is provided by online problem solving, the 
printer’s control panel, the EPSON Status Monitor utility, or by 
running a printer operation check. Refer to the appropriate 
section below.

If you have a specific problem relating to print quality, a printout 
problem not related to print quality, or a paper feeding problem, 
or if the printer does not print at all, refer to the appropriate 
section in this chapter.

To solve a problem, you may need to cancel printing. For details, 
see “Cancelling Printing” on page 10-29.

Online problem solving

You can use online problem solving to diagnose and solve most 
of the problems you may encounter. Refer to the appropriate 
section below.
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For Windows users

The Technical Support Web Site provides you with tips to help 
solve any problems you may encounter when using your printer. 

If you encounter a problem, access the Problem Solver or 
Technical Support in one of the following ways:

❏ From the Windows Start menu

Click Start, point to Programs and then to Epson, then click 
Technical Support.

❏ From Status Monitor 3

Click Technical Support in the Status Monitor 3 dialog box.

❏ From your printer software

Click Technical Support on the Main menu of the printer 
software.

For Macintosh users

EPSON’s Technical Support Web Site provides help with 
problems that cannot be solved using the troubleshooting 
information in your printer documentation.

To access Technical Support, insert the CD in the CD-ROM drive 
and double-click the Technical Support Web Site icon in the 
EPSON window.
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Error indicators

You can identify many common printer problems using the lights 
on your printer’s control panel. If the lights are on or flashing, use 
the following table of panel light patterns to diagnose the 
problem, then follow the recommended corrective measures.

Lights Problem and Solution

O b

Paper out

No paper is loaded 
in the printer.

Check EPSON Status Monitor 3 or EPSON 
StatusMonitor. Load paper in the sheet 
feeder, then press the b maintenance 
button. The printer resumes printing and the 
light goes out.

O b

Paper jam

Paper has jammed 
in the printer.

Check EPSON Status Monitor 3 or EPSON 
StatusMonitor. Press the b maintenance 
button to eject the jammed paper. If the 
error does not clear, open the printer cover 
and remove all of the paper inside, including 
any torn pieces. Then, reload the paper in 
the sheet feeder and press the 
b maintenance button to resume printing. 

F b

Ink low

The black or color 
ink cartridge is 
nearly empty.

Obtain a replacement black or color ink 
cartridge. To determine which cartridge is 
nearly empty, check the ink level using 
EPSON Status Monitor 3 or EPSON 
StatusMonitor.

Black:
T007 (Standard Capacity)
T010 (Light Capacity)
Color:
T009 (Stylus Photo 1290)
T008 (Stylus Photo 890)
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O = on, N = off, F = flashing

EPSON Status Monitor

The EPSON Status Monitor utility provides status messages and 
a graphic display showing the current status of the printer.

O b

Ink out

The black or color 
ink cartridge is 
empty or not 
installed.

Replace the black or color ink cartridge with 
a new one. See “Replacing Ink Cartridges” 
on page 8-1 for details.

Black:
T007 (Standard Capacity)
T010 (Light Capacity)
Color:
T009 (Stylus Photo 1290)
T008 (Stylus Photo 890)

Wrong cartridge (black ink cartridge)

The installed black 
or color ink 
cartridge cannot be 
used by this 
printer.

Use the appropriate black or color ink 
cartridge. See “Replacing Ink Cartridges” on 
page 8-1 for details.

Black:
T007 (Standard Capacity)
T010 (Light Capacity)
Color:
T009 (Stylus Photo 1290)
T008 (Stylus Photo 890)

N P
O b

Carriage error

The print head 
carriage is 
obstructed by 
jammed paper or 
other foreign 
material and 
cannot return to the 
home position.

Turn off the printer. Open the printer cover 
and remove any paper from the paper path 
by hand. Then, turn the printer back on.

If the error does not clear, contact your 
dealer.

F P
F b

Unknown printer error

An unknown 
printer error has 
occurred.

Turn off the printer and contact your dealer.
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If a problem occurs while printing, an error message appears in 
the Progress Meter window.

When the ink is out, click the How To button in the EPSON Status 
Monitor or Progress Meter window and EPSON Status Monitor 
will lead you step-by-step through the cartridge replacement 
procedure.

Running a printer operation check

If you are unable to determine the source of the problem, 
performing a printer operation check can help you determine 
whether the problem comes from the printer or the computer.

To print a printer operation check page, follow these steps.

1. Make sure both the printer and computer are turned off.

2. Disconnect the cable from the printer’s interface connector.

If you use the parallel interface, unlock the wire clips on both 
sides of the interface connector and remove the ground 
connector, if necessary. Then, disconnect the cable from the 
printer’s interface connector.

3. Make sure that A4 size paper is loaded in the sheet feeder.
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4. Hold down the b maintenance button and press the 
P power button to turn on the printer. Then, release only the 
P power button. When the printer starts the operation check, 
release the bmaintenance button.

The printer prints an operation check page which includes the 
version of your printer’s ROM, the ink counter code, and a nozzle 
check pattern. 

Compare the quality of the printed check page with the sample 
shown below. If there are no print quality problems, such as gaps 
or missing segments in the test lines, the printer itself is fine and 
the problem probably lies with the printer software settings, the 
application settings, the interface cable (be sure to use a shielded 
cable), or the computer itself.

The above sample may be shown in black and white, but the actual check 
page prints in color (CMYK).
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If the check page does not print satisfactorily as shown below, 
there is a problem with the printer. For example, if any segment 
of the printed lines is missing, this could mean a clogged ink 
nozzle or a misaligned print head.

The above sample may be show in black and white, but the actual check 
pattern prints in color.

Print Quality Problems

If you are having print quality problems, try the solutions offered 
in this section.

Horizontal banding

Try one or more of these solutions:

❏ Make sure that the printable side of the paper is face up in the 
sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles. 

❏ Clear all settings, and select Automatic as the Mode setting 
on your printer software’s Main menu (Windows) or in the 
Print dialog box (Macintosh).

❏ Check the b error light. If the light is flashing, replace the 
appropriate ink cartridge. See “Replacing Ink Cartridges” on 
page 8-1 for details.

Segments are missing
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❏ Make sure that Maximum is not selected as the Printable Area 
setting in your printer software. When this setting is selected, 
banding may occur in the expanded area.

❏ Make sure that the Media Type selected in the printer 
software is appropriate for the type of media loaded in the 
printer.

❏ Select MicroWeave if the setting is active.

Vertical misalignment or banding

Try one or more of these solutions:

❏ Make sure that the printable side of the paper is face up in the 
sheet feeder.

❏ Run the Print Head Alignment utility. 

❏ Clear the High Speed check box in the Advanced dialog box 
of your printer software’s Advanced dialog box. For 
Windows users, see “Making the Advanced settings” on page 
3-12 for details. For Macintosh users, see “Making the 
Advanced settings” on page 5-11.

❏ Select MicroWeave if the setting is active.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles. 

❏ Make sure that the Media Type setting selected in the printer 
software is appropriate for the type of media loaded in the 
printer.

❏ Make sure that the position of the adjust lever is appropriate 
for the media type. When printing on media of normal 
thickness, set the adjust lever to the “–” position. When 
printing on envelopes or thick media, set the position to “+” .
10-8 Troubleshooting



Color gaps

Try one or more of these solutions:

❏ Make sure that your paper is not damaged, dirty, or too old. 
Also, make sure that the printable side of the paper is face up 
in the sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles. 

❏ Check the b error light. If the light is flashing, replace the 
appropriate ink cartridge. See “Replacing Ink Cartridges” on 
page 8-1.

❏ Adjust the color settings in your application or in your printer 
software’s Advanced dialog box. For instructions, see 
“Making the Advanced settings” on page 3-12 for Windows 
or “Making the Advanced settings” on page 5-11 for 
Macintosh.

❏ Clear all settings, and select Automatic as the Mode setting 
on your printer software’s Main menu (Windows) or in the 
Print dialog box (Macintosh).

❏ Make sure that the Media Type setting selected in the printer 
software is appropriate for the type of media that is loaded in 
the printer.

Incorrect or missing colors

Try one or more of these solutions:

❏ Change the Ink setting in your printer software to Color. For 
instructions, see “Using the Automatic mode” on page 3-9 for 
Windows or “Using the Automatic mode” on page 5-8 for 
Macintosh.
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ls.
❏ Adjust the color settings in your application or in your printer 
software’s Advanced dialog box. For instructions, see 
“Making the Advanced settings” on page 3-12 for Windows 
or “Making the Advanced settings” on page 5-11 for 
Macintosh.

❏ Run the Head Cleaning utility. If colors are still incorrect or 
missing, replace the color ink cartridge. If the problem 
persists, replace the black ink cartridge. See “Replacing Ink 
Cartridges” on page 8-1 for details.

❏ Make sure that you are not using an ink cartridge with an 
expired date printed on the cartridge carton. Also, if you have 
not used the printer for a long time, replace with new ink 
cartridges. See “Replacing Ink Cartridges”on page 8-1 for detai

Blurry or smeared printout

Try one or more of these solutions:

❏ Make sure that the printer is on a flat, stable surface that 
extends beyond the printer base in all directions. The printer 
will not operate properly if it is tilted.

❏ Make sure that your paper is dry and that the printable side 
is facing up. Also, make sure that you are using an acceptable 
paper type. See “Paper” on page A-1 for specifications.

❏ Clear all settings, and select Automatic as the Mode setting 
on your printer software’s Main menu (Windows) or in the 
Print dialog box (Macintosh).

❏ If the paper is curled toward the printable side, flatten it or 
curl it slightly toward the opposite side. 

❏ Set the adjust lever to the “+” position, and make sure the 
Media Type setting in your printer driver is correct.
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❏ Remove each sheet from the output tray as it is printed, 
especially if you are using transparencies.

❏ If you are printing on glossy media or transparencies, place a 
support sheet (or a sheet of plain paper) beneath the stack. Or, 
load only one sheet at a time.

❏ When printing on thick media, set the adjust lever to the “+” 
position. 

❏ Run the Head Cleaning utility.

❏ Run the Print Head Alignment utility. 

❏ Load and eject dry paper several times. If the problem 
persists, ink may have leaked inside the printer, so wipe the 
inside of the printer with a soft, clean cloth.

w
Warning:
Be careful not to touch the gears or rollers inside the printer.

c
Caution:
Be careful not to wipe grease on the metal parts under the 
ink carriage passage.

Wipe here
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Printout Problems Not Related to Print Quality

If one of the following problems has occurred, try the solutions 
listed for the problem.

❏ Incorrect or garbled characters

❏ Incorrect margins

❏ Inverted image

❏ Blank pages print

❏ Printout has smears on the bottom edge

❏ Printing is too slow

Incorrect or garbled characters

Try one or more of these solutions:

❏ Make sure that your printer and printer driver are 
appropriately selected.

❏ Windows Me, 98 or 95 users can clear any stalled print jobs 
from the Spool Manager. For instructions, see “Using EPSON 
Spool Manager” on page 10-30 for Windows Me, 98 and 95 
users.

❏ Turn off the printer and computer. Make sure that the 
printer’s interface cable is securely plugged in.

❏ If you are using Windows NT 4.0, try to uninstall the EPSON 
Printer Port. Click Start, point to Programs and then to 
EPSON Printers, then click EPSON Printer Port Uninstall. 
Follow the on-screen instructions.
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Incorrect margins

Try one or more of these solutions:

❏ Check the margin settings in your application. Make sure that 
the margins are within the printable area of the page. See 
“Paper” on page A-1 for specifications.

❏ Check the settings on the Paper menu (Windows) or in the 
Page Setup dialog box (Macintosh). Make sure the settings are 
appropriate for the paper size you are using.

Inverted image

Clear the Flip Horizontal check box in the printer software, or 
turn off the “Mirror” setting in your application. For instructions, 
see online help for the printer software or for your application.

Macintosh users can refer to “Making the Advanced settings” on 
page 5-11 for details.

Blank pages print

Try one or more of these solutions:

❏ Make sure that your printer and printer driver are 
appropriately selected.

❏ Check the settings on the Paper menu (Windows) or in the 
Page Setup dialog box (Macintosh). Make sure the settings are 
appropriate for the paper size you are using.

❏ Run the Head Cleaning utility to clear any clogged nozzles. 

After trying one or more of these solutions, run a printer operation 
check to check your results. See “Running a printer operation 
check” on page 10-5 for details.
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Printout has smears on the bottom edge

Try one or more of these solutions:

❏ If the paper is curled toward the printable side, flatten it or 
curl it slightly toward the opposite side.

❏ Set the adjust lever to the “+” position, and clear the High 
Speed check box in your printer software’s Advanced dialog 
box. The Advanced dialog box is accessible through the Main 
menu (Windows) or the Print dialog box (Macintosh) when 
Custom is selected as the Mode setting. To turn this option 
off, you may also need to change the Print Quality setting.

Printing is too slow

Try one or more of these solutions:

❏ Make sure that the Media Type setting in your printer 
software is correct. For instructions, see “Making the Media 
Type setting” on page 3-4 for Windows or “Making the Media 
Type setting” on page 5-3 for Macintosh.

❏ Select Automatic as the Mode setting on your printer 
software’s Main menu (Windows) or in the Print dialog box 
(Macintosh) and then move the slider to Speed. For 
instructions, see “Using the Automatic mode” on page 3-9 for 
Windows or “Using the Automatic mode” on page 5-8 for 
Macintosh.

❏ Close any applications that you are not using at the moment.

❏ If you upgraded from Windows 95 to Windows 98, uninstall 
the printer software using Add/Remove Programs in the 
Control Panel in Windows, then install the software again.
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Paper Does Not Feed Correctly

If one of the following problems has occurred, try the solution(s) 
listed for that problem.

❏ Paper does not feed

❏ Multiple pages feed

❏ The paper jams

❏ Paper is not ejected fully or is wrinkled

❏ Paper does not feed correctly when using roll paper

❏ Paper does not feed correctly when using the double-sided 
printing feature

Paper does not feed

Remove the stack of paper and make sure of the following:

❏ The paper is not curled or creased.

❏ The paper is not too old. See the instructions that came with 
the paper for more information.

❏ The paper is not loaded above the arrow on the left edge 
guide.

❏ Paper is not jammed inside the printer. If it is, remove the 
jammed paper.

❏ The black and/or color ink cartridges are not empty. If one is, 
replace the appropriate cartridge. To determine which 
cartridge is empty, see “Replacing Ink Cartridges” on page 
8-1.
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Then, load the paper again. Make sure that you follow any special 
loading instructions that came with your paper. See also “Paper 
Handling” on page 19.

Multiple pages feed

❏ Make sure that the paper stack fits under the arrow mark 
located on the inside surface on the left edge guide.

❏ Make sure that the left edge guide is snug to the left edge of 
the paper.

❏ Make sure that the paper is not curled or folded. If so, flatten 
it or curl it slightly toward the opposite side before loading.

❏ Make sure that the position of the adjust lever is appropriate 
for the media type. When printing on media of normal 
thickness, set the adjust lever to the “-” position. When 
printing on envelopes and thick media, set the position to “+” .

❏ Remove the stack of paper and make sure that the paper is 
not too thin. See “Paper” on page A-1 for specifications. Fan 
the edges of the stack to separate the sheets, then reload the 
paper.

❏ If too many copies of a document are being printed, check the 
Copies setting on the printer software’s Paper menu 
(Windows) or in the Print dialog box (Macintosh) and in your 
application. For instructions, see “Making Settings on the 
Paper Menu” on page 3-20 for Windows or “Making settings 
in the Print dialog box” on page 5-3 for Macintosh.
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The paper jams

Press the bmaintenance button to eject the jammed paper. If the 
error does not clear, open the printer cover and remove all of the 
paper inside, including any torn pieces. Then, reload the paper in 
the sheet feeder and press b maintenance button to resume 
printing.

Note:
If you cannot remove a foreign object easily by yourself, do not use force 
and do not disassemble the printer. Call your dealer for assistance.

If your paper jams frequently, make sure of the following:

❏ The paper is smooth, not curled or wrinkled.

❏ Make sure that the printable side of the paper is face up in the 
sheet feeder.

❏ The paper stack was fanned before loading.

❏ The paper is not loaded above the arrow on the left edge 
guide.

❏ The left edge guide is adjusted to fit your paper.

❏ Make sure that the printer is on a flat, stable surface that 
extends beyond the printer base in all directions. The printer 
will not operate properly if it is tilted.

Paper is not ejected fully or is wrinkled

Try one or more of these solutions:

❏ If the paper does not eject fully, press the b maintenance 
button, then open the printer cover and remove the paper. 
Also, check the Paper Size setting in your application or 
printer software.
Troubleshooting 10-17



❏ If the paper is wrinkled when it comes out, it may be damp 
or too thin. Load a new stack.

Note:
Store any unused paper in its original packaging in a dry area. See 
“Paper” on page A-1 for specifications.

Paper does not feed correctly when using roll 
paper

If roll paper does not feed correctly, try the following:

❏ Make sure the end of the roll is cut perpendicularly to the 
edges. If it is cut on a diagonal, the paper may not feed 
smoothly. Always use a triangle or other tool to ensure that 
the end of the roll is cut perpendicularly.

❏ Make sure the paper is not curled. If the paper is curled, the 
paper may not feed smoothly. Flatten it before loading to 
avoid paper-feeding problems. To uncurl the paper, roll the 
paper inside the protective film packaged with the printer in 
the direction opposite to the paper’s curl. It is enough to flatten 
the paper by 100 mm. It is not necessary to uncurl the whole 
roll.

❏ Be sure to hold the paper in place with your hand when 
feeding it into the printer. To load the paper correctly, you 
must hold the paper in place with your hand while you press 
the z roll paper button.

❏ Make sure the paper support is removed and the output tray 
extension is closed. When using roll paper, you must remove 
the paper support and shorten the output tray extension (the 
second and third trays should be closed).

❏ Confirm that Roll Paper is selected as the Paper Source setting 
in the printer software. If Roll Paper is not selected, paper will 
feed unnecessarily after each print job. 
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Change the setting to Roll Paper, then cut the paper off at the 
back of the printer. Turn the printer power off to remove the 
paper from the front of the printer, then reload the roll paper 
as described in “Loading the Roll Paper” on page 2-1.

❏ Check for jammed paper or foreign objects inside the printer.
Open the printer cover and make sure that no paper or foreign 
objects are jammed in the printer. Check around the sheet 
feeder slot as well. Remove any jammed paper as described 
in “Removing the Roll Paper from the Printer” on page 2-13. 
Do not attempt to remove the paper by force. If you cannot 
remove the paper or foreign object easily, contact your dealer 
for assistance.

Paper does not feed correctly when using the 
double-sided printing feature

If multiple pages feed when using the double-sided printing 
feature, remove the paper as instructed in “Multiple pages feed” 
on page 10-16. You may be able to reuse the pages that were fed 
in error. Make sure that the paper is not wrinkled or creased, then 
reload it properly to ensure that no pages are skipped and that 
the document is printed correctly.

If paper jams when using the double-sided printing feature, 
remove the paper as instructed in “The paper jams” on page 10-17. 
If a number of print jobs have been sent to the printer, check the 
page settings in your application and confirm that the paper is 
loaded properly to ensure that no pages are skipped and that the 
document is printed correctly.

Printer Does Not Print

If the printer does not print, check and see if one of the following 
error indications is displayed, then try the solutions listed.
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❏ All lights are off

❏ Lights came on and then went out

❏ Only the power light is on

❏ The b error light is flashing or on

❏ One of the ink out lights is flashing or on

❏ Ink out lights are on and the other lights are flashing
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All lights are off

Try one or more of these solutions:

❏ Press the P power button to make sure that the printer is on.

❏ Turn off the printer and make sure that the power cord is 
securely plugged in.

❏ Make sure that your outlet works and is not controlled by a 
wall switch or timer.

Lights came on and then went out

The printer’s voltage may not match the outlet rating. Turn off the 
printer and unplug it immediately. Then, check the printer labels.

If the voltage does not match, DO NOT PLUG YOUR PRINTER 
BACK IN. Contact your dealer.

Only the power light is on

Try one or more of these solutions:

❏ Turn off the printer and computer. Make sure that the 
printer’s interface cable is securely plugged in.

❏ Make sure that there is no packing material in the printer.

❏ Turn off the printer and the computer and disconnect the 
printer’s interface cable. Then, print an operation check page. 
See “Running a printer operation check” on page 10-5.

If the check page prints correctly, make sure that the printer 
software and your application are installed correctly.

❏ If you are trying to print a large image, your computer may 
not have enough memory to print. Try printing a smaller 
image.
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❏ If you are using Windows NT 4.0, try to uninstall the EPSON 
Printer Port. Click Start, point to Programs and then to 
EPSON Printers, then click EPSON Printer Port Uninstall. 
Follow the on-screen instructions.

❏ Windows 98 or 95 users can clear any stalled print jobs from 
the Spool Manager. For instructions, see “Using EPSON Spool 
Manager” on page 10-30 for Windows Me, 98 and 95 users.

❏ If the printer sounds like it is trying to print, but is unable to, 
run the Head Cleaning utility. 

If this does not work, replace the ink cartridges. See 
“Replacing Ink Cartridges” on page 8-1 for instructions.

Error light is flashing or on

Check EPSON Status Monitor 3 or EPSON StatusMonitor to find 
the cause of the error, then try one or more of these solutions:

❏ If the b error light is on and paper is jammed in the printer, 
remove the paper from the printer.

❏ If the b error light is on and no paper is loaded, load more 
paper in the sheet feeder.

❏ If the b error light is flashing, ink is low. Obtain a 
replacement cartridge of the appropriate type. To determine 
which cartridge is low, see “Replacing Ink Cartridges” on 
page 8-1.

❏ If the b error light is on and ink is out, replace the 
appropriate ink cartridge. To determine which ink cartridge 
is empty, see “Replacing Ink Cartridges” on page 8-1.
10-22 Troubleshooting



Error light is on and power light is flashing

Follow the steps below.

1. Press the bmaintenance button, then remove any paper in 
the printer.

2. Turn the printer off. Check for and remove any foreign objects 
or pieces of paper from inside the printer. Also, make sure 
that there is sufficient space around the vent on the back of 
the printer to allow proper ventilation. Remove any objects 
blocking the vent. Then, turn the printer back on.

Note:
If you cannot remove a foreign object easily by yourself, do not use 
force and do not disassemble the printer. Call your dealer for 
assistance.

3. If the error does not clear, contact your dealer.

Correcting USB Problems

If you are having difficulty using your printer with a USB 
connection, see if your problem is listed below, then follow the 
instructions given to resolve the problem.

Printer does not work correctly with the USB 
cable

If your printer does not work correctly with the USB cable, try one 
or both of these solutions:

❏ Use the USB cable recommended in “System Requirements” 
on page A-12.
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❏ For best results, you should connect the printer directly to the 
computer’s USB port. If you must use multiple USB hubs, we 
recommend that you connect the printer to the first tier hub.

Operating System

Your computer must be a Windows 98 or Windows 2000 pre-
installed model. You may not be able to install or run the USB 
Printer Driver on a computer which is not equipped with a USB 
port or which has been upgraded from Windows 95 to 
Windows 98 or 2000. For Windows Me users, your computer 
must be a Windows Me pre-install model or upgraded from 
Windows 98 pre-installed model.

For details about your computer, contact your dealer.

Printer software installation

Please take notice about the following.

❏ When using Windows 2000, you must follow the steps in the 
Quick Start Manual to install the printer software; otherwise, 
Microsoft’s Universal driver may be installed instead. To 
check if the Universal driver has been installed, open the 
Printers folder and right-click the icon for your printer. To 
open the printer driver, click Printing Preferences on the 
shortcut menu that appears, then right-click anywhere in the 
driver. If About is displayed in the shortcut menu that 
appears, click it. A message box with the words “Unidrv 
Printer Driver” appears. You must reinstall the printer 
software as described in the Quick Start Manual. If About is 
not displayed, the printer software has been installed 
correctly.
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❏ If the Digital Signature Not Found dialog box appears during 
the installation process, click Yes. If you click No, you must 
follow the steps in the Quick Start Manual to install the printer 
software again.

USB driver installation

For Windows Me, 98 and 2000 users, follow the directions below 
to ensure that the USB driver is installed correctly.

Note:
The illustrations used in this section show the procedure for 
Windows 98.

1. Click the Start button, point to Settings, and click Printers. 
Make sure that the icon for your printer appears in the Printers 
window.

Select the icon for your printer, then click Properties on the 
File menu.
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2. For Windows 98 users, click the Details tab and make sure 
that EPUSBx: (EPSON Stylus Photo 1290 or 890) is 
displayed in the Print to the following port list box. For 
Windows 2000 users, click the Ports tab and make sure that 
USBxxx, EPSON Stylus Photo 1290 or 890 is displayed in 
the Print to the following port(s) list box.

Note:
If the correct port is not displayed, refer to the next section, “Make 
sure that EPSON USB Printer Devices appears on the Device 
Manager menu (for Windows Me and 98)”.

The Device Manager menu (for Windows Me and 98 only)

If you canceled the plug-and-play driver installation before the 
procedure was complete, either the USB printer device driver or 
the printer software may be incorrectly installed.

Follow the steps below to check the installation and reinstall the 
drivers.

1. Turn the printer on. Plug the USB cable into the printer and 
the computer.
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2. Right-click the My Computer icon on your desktop, then click 
Properties.

3. Click the Device Manager tab.

If your drivers are correctly installed, EPSON USB Printer 
Devices should appear on the Device Manager menu.

If EPSON USB Printer Devices does not appear on the 
Device Manager menu, click the plus (+) sign beside Other 
devices to view the installed devices. 

If USB Printer appears under Other devices, the USB printer 
device driver is not installed correctly. If EPSON Stylus 
Photo 1290 or 890 appears, the printer software is not 
installed correctly.

If neither USB Printer nor EPSON Stylus Photo 1290 or 890 
appears under Other devices, click Refresh or unplug the 
USB cable from the printer, then plug it into the printer again.
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4. Under Other devices, select USB Printer or EPSON Stylus 
Photo 1290 or 890 and click Remove. Then, click OK.

5. When the following dialog box appears, click OK. Then click 
OK to close the System Properties dialog box.

6. Turn off the printer and restart your PC. Then, reinstall the 
drivers from the beginning, following the instructions in the 
Quick Start Manual.

Note:
If the problem does not clear, contact your dealer.
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Reinstall the USB printer device driver and printer software 
(Windows 98 only)

If the solutions above do not correct the problem, try reinstalling 
the USB printer device driver and the printer software. First, 
uninstall EPSON Printer Software using the Add/Remove 
Programs utility in the Control Panel, then uninstall EPSON USB 
Printer Devices. Next, reinstall the software as described in the 
Quick Start Manual. If EPSON USB Printer Devices is not 
registered in the Add/Remove Programs list, access the CD-ROM 
and double-click epusbun.exe. in Win9x folder. Then follow the 
on-screen instructions.

Cancelling Printing

If you encounter problems while printing, you may need to cancel 
printing. To cancel printing, follow the instructions in the 
appropriate section below.

For Windows Me, 98 and 95 users

It is possible to cancel printing using either the Progress Meter or 
EPSON Spool Manager. Refer to the appropriate section below.
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Using the Progress Meter

When you send a print job to the printer, the Progress Meter 
appears on your computer screen.

Click the Stop button to cancel printing.

Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If 
it receives two or more print jobs at one time, it holds them in the 
order that they were received (with printers on a network this 
may be called a print queue). When a print job reaches the top of 
the line, the EPSON Spool Manager sends the job to the printer. 
From the Spool Manager, you can cancel print jobs. You can also 
view print status information about the print jobs which have 
been sent to your printer, as well as pause and resume or restart 
selected print jobs.

Note:
EPSON Spool Manager is not available for Windows 2000, 
Windows NT, or Macintosh.
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After you send a print job, an EPSON Stylus Photo 1290 or 890 
button appears on the taskbar. Click this button to open the 
EPSON Spool Manager.

For Windows 2000 and NT 4.0 users

When you send a print job to the printer, the Progress Meter 
appears on your computer screen.

Click the Stop button to cancel printing.

For Macintosh users

The procedure for canceling printing for Macintosh varies, 
depending upon whether background printing is on or off. Refer 
to the appropriate section below.
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When background printing is on

Follow the steps below to cancel a print job.

1. Select EPSON Monitor3 from the application menu.

2. Press the P power button to turn off the printer.

3. In the Document Name list, select the document which is 
printing, then click the  Stop icon button to cancel the print 
job.

When background printing is off

Follow the steps below to cancel a print job.

1. Press the P power button to turn off the printer.

2. Hold down the J command key on your keyboard and press 
the period (.) key to cancel the print job.
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Technical Support Web Site

EPSON’s Technical Support Web Site provides help with 
problems that cannot be solved using the troubleshooting 
information in your printer documentation. If you have a Web 
browser and can connect to the Internet, access that site at:

http://support.epson.net/StylusPhoto1290

http://support.epson.net/StylusPhoto890

Regional Customer Services

If your EPSON product is not operating properly and you cannot 
solve the problem using the troubleshooting information in your 
product documentation, contact customer support services for 
assistance. If customer support for your area is not listed below, 
contact the dealer from whom you purchased your product.

Customer support will be able to help you much more quickly if 
you provide the following information.

❏ Product serial number
(The serial number label is usually on the back of the product)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the product 
software)

❏ Brand and model of your computer

❏ Name and version of your computer operating system

❏ Names and versions of the applications you normally use 
with your product
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Chapter 11

Options and Consumable Products

Options

The following options are available for your printer.

Interface cables

You can use any interface cables that meet the following 
specifications. See your computer manual for any additional 
requirements.

❏ Parallel Interface Cable (shielded) from D-SUB 25-pin 
(computer) to 36-pin Amphenol 57 Series (printer)

❏ USB Interface Cable (shielded) from Series A 4-pin 
(computer) to series B 4-pin (printer).

Note:
Depending on your geographic location, this cable may not be supplied.

c
Caution:
Use only interface cables which meet the specifications listed 
above. Using other cables may cause the printer to malfunction.

Consumable products

The following ink cartridges and EPSON special media are 
available for your printer.
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Ink cartridges

You can use the following cartridges with your printer.

Note:
The product numbers of ink cartridges may vary by location.

Media types

EPSON offers specially-designed media for ink jet printers to 
meet most high-quality printing needs.

Note:
For the latest information of the available media, visit our regional 
customer service web site. See “Regional Customer Services” on page 
10-33 for details.

Type of ink Product numbers of ink

Black ink cartridge Standard Capacity: T007

Color ink cartridge Stylus Photo 1290: T009
Stylus Photo 890: T008

EPSON Premium Ink Jet Plain Paper (A4)
EPSON Bright White Ink Jet Paper (A4)

S041214
S041442

EPSON 360 dpi Ink Jet Paper (A4) S041059

EPSON 360 dpi Ink Jet Paper (A3)* S041065

EPSON 360 dpi Ink Jet Paper (Super A3/Super B)*S041066

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Iron-On Cool Peel Transfer Paper (A3)* S041238
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EPSON Photo Quality Ink Jet Paper (A4) S041061

EPSON Photo Quality Ink Jet Paper (A3)* S041068

EPSON Photo Quality Ink Jet Paper 
(Super A3/Super B)*

S041069

EPSON Photo Quality Ink Jet Paper (B)* S041070

EPSON Photo Quality Ink Jet Cards (A6) S041054

EPSON Photo Quality Ink Jet Cards (5 × 8”) S041121

EPSON Photo Quality Ink Jet Cards (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheets (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 × 8” 
(with envelopes)

S041148

EPSON Ink Jet Greeting Cards 8 × 10” 
(with envelopes)

S041149

EPSON Matte Paper-Heavyweight (A4) S041256

EPSON Matte Paper-Heavyweight (B) S041266

EPSON Matte Paper-Heavyweight (A3)* S041260

EPSON Matte Paper-Heavyweight 
(Super A3/Super B)*

S041263
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EPSON Photo Paper (A4) S041140

EPSON Photo Paper (A3)* S041142

EPSON Photo Paper (Super A3/Super B)* S041143

EPSON Photo Paper (B)* S041156

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (4 × 6” No Perforations) S041458

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Photo Paper (89 mm × 7 M) S041281

EPSON Photo Paper (100 mm × 8 M) S041279

EPSON Photo Paper (210 mm × 10 M) S041280

EPSON Photo Paper (329 mm × 10 M)* S041233

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Photo Paper Cards (A4) S041177

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (A3)* S041073

EPSON Photo Quality Glossy Film 
(Super A3/Super B)*

S041074

EPSON Photo Quality Glossy Film (B)* S041075

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176
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* Only with the EPSON Stylus Photo 1290.

EPSON Ink Jet Transparencies (A4) S041063

EPSON Premium Glossy Photo Paper (A4) S041287

EPSON Premium Glossy Photo Paper (A3)* S041288

EPSON Premium Glossy Photo Paper (B)* S041290

EPSON Premium Glossy Photo Paper 
(Super A3/Super B)*

S041289

EPSON Premium Glossy Photo Paper 
(100mm × 8M)

S041302

EPSON Premium Glossy Photo Paper 
(210mm × 10M)

S041376

EPSON Premium Glossy Photo Paper 
(329mm × 7M)*

S041378

EPSON Ink Jet Back Light Film (A3)* S041131
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Appendix A

Printer Specifications

Printing

Paper

Note:
Since the quality of any particular brand or type of paper may be changed 
by the manufacturer at any time, EPSON cannot attest to the quality of 
any non-EPSON brand or type of paper. Always test samples of paper 
stock before purchasing large quantities or printing large jobs.

Printing method On-demand ink jet

Nozzle configuration Monochrome (black) 48 nozzles

Color (cyan, magenta, yellow, light cyan, light 
magenta) 240 nozzles
(48 [each color] × 5)

Resolution Maximum 2880 dpi × 720 dpi

Print direction Bidirectional with logic seeking

Control code EPSON ESC/P Raster

EPSON Remote

Input buffer 256 KB
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Paper specifications

Single sheets:

Envelopes:

Stylus Photo 1290 Stylus Photo 890

Size Super A3/Super B 
(329 mm × 483 mm)

A3 (297 mm × 420 mm)

A4 (210 mm × 297 mm)

A5 (148 mm × 210 mm)

B (279 mm × 432 mm)

Letter 
(216 mm x 279 mm)

Half letter 
(139,7 mm x 215,9 mm)

Legal (216 mm x 356 mm)

Executive 

(184.2 mm × 266.7 mm)

5x7" (127 mm × 178 mm)

3.5x5" (89 mm × 127 mm)

A4 (210 mm × 297 mm)

A5 (148 mm × 210 mm)

Letter (216 mm x 279 mm)

Half letter 
(139,7 mm x 215,9 mm)

Legal (216 mm x 356 mm)

Executive 

(184.2 mm × 266.7 mm)

5x7" (127 mm × 178 mm)

3.5x5" (89 mm × 127 mm)

Paper types Plain bond paper, special paper distributed by EPSON

Thickness
(for plain 
bond paper)

0.08 mm to 0.11 mm 

Weight
(for plain 
bond paper)

64 g/m² to 90 g/m² 

Stylus Photo 1290 Stylus Photo 890

Size No. 10 (104.8 mm × 241 mm) 

DL (110 mm × 220 mm) 

C6 (114 mm × 162 mm)

132 mm × 220 mm

Paper types Plain bond paper, air mail
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Index Cards:

Transparencies, Photo Quality Glossy Film:

Self Adhesive Sheets:

Thickness 0.16 mm to 0.52 mm 

Weight 45 g/m² to 75 g/m² 

Stylus Photo 1290 Stylus Photo 890

Size A6 (105 mm × 148 mm)

8 × 10” (203 mm × 254 mm)

5 × 8” (127 mm × 203 mm)

Paper types Special paper distributed by EPSON

Stylus Photo 1290 Stylus Photo 890

Size Super A3/Super B 
(329 mm × 483 mm) for 
glossy film 

A3 (297 mm × 420 mm) 
for glossy film

B (279 mm × 432 mm) 
for glossy film

A4 (210 mm × 297 mm)

Letter (216 mm x 279 mm)

A6 (105 mm × 148 mm) 
for glossy film

A4 (210 mm × 297 mm)

Letter (216 mm x 279 mm)

A6 (105 mm × 148 mm) 
for glossy film

Paper types Special paper distributed by EPSON

Stylus Photo 1290 Stylus Photo 890

Size A4 (210 mm × 297 mm)

Paper types Special paper distributed by EPSON

Stylus Photo 1290 Stylus Photo 890
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Matte Paper-Heavyweight:

Photo Paper:

Stylus Photo 1290 Stylus Photo 890

Size Super A3/Super B 
(329 mm × 483 mm)

A3 (297 mm × 420 mm)

B (279 mm × 432 mm)

Letter (216 mm x 279 mm)

A4 (210 mm × 297 mm)

Letter (216 mm x 279 mm)

A4 (210 mm × 297 mm)

Paper types Special paper distributed by EPSON

Stylus Photo 1290 Stylus Photo 890

Size Super A3/Super B 
(329 mm × 483 mm)

A3 (297 mm × 420 mm)

B (279 mm × 432 mm)

A4 (210 mm × 297 mm)

Letter (216 mm x 279 mm)

Panoramic 
(210 mm × 594 mm)

100 mm × 150 mm

4 x 6" (102 mm × 152 mm)

4 x 6" 
(113.6 mm × 175.4 mm)

216 mm × 338 mm

89 mm × 7 M

100 mm × 8 M

210 mm × 10 M

329 mm × 10 M

A4 (210 mm × 297 mm)

Letter (216 mm x 279 mm)

Panoramic 
(210 mm × 594 mm)

100 mm × 150 mm

4 x 6" (102 mm × 152 mm)

4 x 6" 
(113.6 mm × 175.4 mm)

216 mm × 338 mm

89 mm × 7 M

100 mm × 8 M

210 mm × 10 M

Paper types Special paper distributed by EPSON
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Premium Glossy Photo Paper:

Photo Stickers:

Back Light Film:

Note:
❏ Poor quality paper may reduce print quality and cause paper jams 

or other problems. If you encounter problems, switch to a higher 
grade of paper.

❏ Do not load curled or folded paper.

Stylus Photo 1290 Stylus Photo 890

Size Super A3/Super B 
(329 mm × 483 mm)

A3 (297 mm × 420 mm)

B (279 mm × 432 mm)

Letter 
(216 mm x 279 mm)

A4 (210 mm × 297 mm)

100mm x 8M

210mm x 10M

329mm x 10M

Letter 
(216 mm x 279 mm)

A4 (210 mm × 297 mm)

100mm x 8M

210mm x 10M

Paper types Special paper distributed by EPSON

Stylus Photo 1290 Stylus Photo 890

Size A6 (105 mm × 148 mm) with 4 or 16 frames

Paper types Special paper distributed by EPSON

Stylus Photo 1290

Size A3 (297 mm × 420 mm)

Paper types Special paper distributed by EPSON
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❏ Use paper under normal conditions:
Temperature 15 to 25°C 
Humidity 40 to 60% RH

❏ EPSON Photo Quality Glossy Film and Self Adhesive Sheets should 
be stored under the following conditions:
Temperature 15 to 30°C 
Humidity 20 to 60% RH

❏ EPSON Ink Jet Back Light Film should be stored under the following 
conditions:
Temperature 23 to 32°C 
Humidity 40 to 60% RH

The film maybe smudged if you print below 22°C

Printable area

Single sheets (including panoramic size) and index cards

Envelopes

Normal No Margins**

A

B-L B-R

C

A

B-L B-R

C
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Note:
Always load paper into the sheet feeder short edge first. Load 
envelopes flap edge first with the flap side down.

Diagonal lines show printable area.

A: The minimum top margin is 3.0 mm.

When loading multiple sheets of EPSON Photo 
Quality Glossy Film, the minimum top margin is 
30.0 mm.

B-L: The minimum left margin is 3.0 mm.

B-R: The minimum right margin is as follows:
3.0 mm for single sheets and C6 envelopes.
7.0 mm for DL envelopes.
28.0 mm for No. 10 envelopes.

C: The minimum bottom margin is 14.0 mm.

✽: You can extend the minimum bottom margin to 
3 mm by selecting Maximum as the Printable Area 
setting on the printer software’s Paper menu 
(Windows) or in the Page Setup dialog box 
(Macintosh). However, print quality may decline in 
the expanded area. Before printing large jobs using 
this setting, print a single sheet to confirm printout 
quality.

✽✽: When printing with the No Margins feature, print 
quality may decline in the top and bottom areas of 
the printout, or the area may be smeared.
Printer Specifications A-7



Ink Cartridges

Black ink cartridge (T007)

There are two types of black ink cartridges. The Light Capacity 
ink cartridge (T010) contains half of the a mount of ink as the 
standard capacity in cartridge.(T007) 

Color ink cartridge

You need to select a color ink cartridge that is available for your 
printer.

EPSON Stylus Photo 1290 (T009)
EPSON Stylus Photo 890 (T008)

Color Black

Print 
capacity*

Standard Capacity (T007): 540 pages (A4, text at 360 dpi)

Light Capacity (T010): 270 pages (A4, text at 360 dpi)

Cartridge life 2 years from production date
(within 6 months after opening package, at 25°C )

Temperature Storage:
-20 to 40°C 

1 month at 40°C 

Transit:
-30 to 60°C 

1 month at 40°C 

120 hours at 60°C 

Freezing:**
-16°C 

Dimensions 20.1 mm (W) × 60.0 mm (D) × 38.5 mm (H)
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* The figure given is based upon continuous printing after ink replacement. The 
actual print capacity may vary, depending on how often you use the print head 
cleaning function and how often you turn the printer on.

** Ink thaws and is usable after approximately 3 hours at 25°C.

c
Caution:
❏ EPSON recommends the use of original EPSON ink 

cartridges only. Products not manufactured by EPSON may 
cause damage to your printer not covered by EPSON’s 
warranties.

❏ Do not use an ink cartridge if the date on the package has 
expired.

❏ Do not refill the ink cartridge. The printer calculates the 
amount of ink remaining using an IC chip on the ink 
cartridge, so even if the cartridge is refilled, the IC chip will 
report that it is empty.

Stylus Photo 1290 Stylus Photo 890

Color Cyan, Magenta, Yellow, Light cyan and Light magenta

Print 
capacity*

330 pages (A4, 360 dpi, 5% 
duty each color)

220 pages (A4, 360 dpi, 5% 
duty each color)

Cartridge life 2 years from production date 
(within 6 months of opening the package at 25°C )

Temperature Storage:
-20 to 40°C 

1 month at 40°C 

Transit:
-30 to 60°C 

1 month at 40°C 

120 hours at 60°C 

Freezing:**
-18°C 

Dimensions 49.1 mm (W) × 84.05 mm 
(D) × 41.8 mm (H)

49.1 mm (W) × 60.0 mm (D) 
× 38.5 mm (H)
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Mechanical

Stylus Photo 1290 Stylus Photo 890

Paper feed 
method

Friction

Paper path Sheet feeder, rear entry

Sheet 
feeder 
capacity

About 100 sheets at 64 g/m² paper

Dimensions Storage

Width: 609 mm 

Depth: 311 mm 

Height: 175 mm 

Storage

Width: 471 mm 

Depth: 290 mm 

Height: 302 mm 

Printing

Width: 609 mm 

Depth: 766 mm 

Height: 414 mm 

Printing

Width: 471 mm 

Depth: 631 mm 

Height: 175 mm 

Weight 8.4 kg without the ink 
cartridges

6.0 kg without the ink 
cartridges
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Electrical

Note:
Check the label on the back of the printer for the voltage of your printer.

Environmental

* Stored in a shipping container

** Without condensation

Input voltage range 198 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0,2 A

Power consumption Approx. 15 W (ISO10561 Letter 
Pattern)
Approx. 3 W in standby mode

Temperature Operation: 
10 to 35°C 

Storage: 
-20 to 40°C 

1 month at 40°C 

Transit:*
-20 to 60°C

120 hours at 60°C 

Humidity Operation: 
20 to 80% RH

Storage:*,** 
5 to 85% RH
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Safety Approvals

System Requirements

Refer to the appropriate section below for the minimum and 
recommended computer system requirements necessary to use 
this printer.

For Windows computers

To use your printer, you need Microsoft® Windows® Millennium 
Edition, Windows® 98, Windows® 95, Windows® 2000, or 
Windows NT® 4.0 installed and the printer must be connected via 
a shielded, twisted-pair parallel cable. If you want to connect your 
printer to a USB port, you need a Windows 98 or Windows 2000 
pre-installed PC equipped with a USB port and the printer must 
be connected via a standard, shielded USB cable.

Low Voltage Directive 73/23/EEC EN 60950

EMC Directive 89/336/EEC EN 55022 Class B

EN 55024

EN 61000-3-2

EN 61000-3-3
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Your computer should also meet the following system 
requirements.

Your computer dealer can help you update your system if it does 
not meet these requirements.

For Macintosh computers

To connect this printer to Apple® Macintosh® computers, you 
must use a USB cable.

Your Macintosh must also meet the following system 
requirements.

Minimum System Requirements Recommended System

Pentium 150 MHz processor for 
Windows Me

i486/66 MHz processor for 
Windows 98

i486/25 MHz processor for 
Windows 95 and NT 4.0

Pentium 133 MHz processor for 
Windows 2000

Pentium 150 MHz or higher 
processor for Windows Me

Pentium or higher processor for 
Windows 98, 95, and NT 4.0

Pentium 133 MHz or higher 
processor for Windows 2000

16 MB RAM for Windows 98, 95, and 
NT 4.0

32 MB RAM for Windows Me and 
2000

32 MB RAM or more for 
Windows Me, 98 and 95

64 MB RAM or more for 
Windows 2000 and NT 4.0

20 MB hard disk space for 
Windows Me, 98 and 95

40 MB hard disk space for 
Windows 2000 and NT 4.0

50 MB hard disk space or more for 
Windows Me, 98 and 95

100 MB hard disk space or more for 
Windows 2000 and NT 4.0

VGA monitor VGA or better monitor

Minimum System Requirements Recommended System

Mac OS 8.1 Mac OS 8.5.1/ 8.6 / 9.X

14 MB of available memory
(For Stylus Photo 1290)

29 MB of available memory or more
(For Stylus Photo 1290)
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Note:
❏ The amount of available memory varies according to the number and 

kind of applications that are open. To see how much memory is 
available, choose About This Computer from the Apple menu and 
refer to the memory size (listed in kilobytes) under “Largest Unused 
Block” (1,024K=1 MB).

❏ The memory requirements above are for printing on Letter size 
paper. These requirements may vary depending on the size of the 
paper, the type of application you are using, and the complexity of 
the document that you want to print.

In addition to these system and memory requirements, you need 
15 MB of free hard disk space to install your printer software. To 
print, you also need extra hard disk space amounting to about 
twice the size of the file that you want to print.

14 MB of available memory
(For Stylus Photo 890)

29 MB of available memory or more
(For Stylus Photo 890)

16 MB of available memory when 
background printing is turned on.
(For Stylus Photo 1290)

48 MB of available memory or more 
when background printing is turned 
on.
(For Stylus Photo 1290)

16 MB of available memory when 
background printing is turned on.
(For Stylus Photo 890)

48 MB of available memory or more 
when background printing is turned 
on.
(For Stylus Photo 890)
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Glossary

The following definitions apply specifically to printers.

application
Software that helps you carry out a particular task, such as word processing or 
financial planning.

ASCII
American Standard Code for Information Interchange. A standardized coding 
system for assigning numerical codes to letters and symbols.

banding
The horizontal lines that sometimes appear when printing graphics. This occurs 
when the print head is misaligned. See also MicroWeave.

bit
A binary digit (0 or 1), which is the smallest unit of information used by a printer 
or computer.

brightness
The lightness or darkness of an image.

buffer
The portion of the printer’s memory used to store data before printing it.

byte
A unit of information consisting of eight bits.

characters per inch (cpi)
A measure of the size of text characters, sometimes referred to as pitch.

CMYK
Cyan (blue-green), magenta, yellow, and black. These colored inks are used to 
create the subtractive system array of printed colors.

color matching
A method of processing color data so that colors displayed on a computer screen 
closely match colors in printouts. A variety of color-matching software is 
available.

ColorSync
Macintosh software that is designed to help you get WYSIWYG (what you see is 
what you get) color output. This software prints colors as you see them on your 
screen.

cpi
See characters per inch (cpi).
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default
A value or setting that takes effect when the equipment is turned on, reset, or 
initialized.

dithering
A halftoning method in which dots are arranged in an orderly pattern. Dithering 
works best when printing images with solid colors, such as charts and graphs.

DMA
Direct Memory Access. A data transfer feature that bypasses a computer’s CPU 
and allows direct communication between a computer and peripheral devices 
(like printers), and between one peripheral device and another.

dpi
Dots per inch. The dpi measures the resolution. See also resolution.

drive
A memory device, such as a CD-ROM, hard disk, or floppy disk drive. In 
Windows, a letter is assigned to each drive for easy management.

driver
Software that sends instructions to a computer peripheral to tell it what to do. 
For example, your printer driver accepts print data from your word processor 
application and sends instructions to the printer on how to print this data. 
Together, the printer driver and printer utilities are referred to as "printer 
software". See also printer software.

economy printing
Printing in which images are printed with fewer dots to save ink.

error diffusion
Error diffusion blends individual colored dots with the colors of the surrounding 
dots to create the appearance of natural colors. By blending colored dots, the 
printer can achieve excellent colors and subtle color gradation. This method is 
best suited for printing documents that contain detailed graphics or photographic 
images.

ESC/P
Abbreviation for EPSON Standard Code for Printers, the system of commands 
your computer uses to control your printer. It is standard for all EPSON printers 
and is supported by most applications for personal computers.

ESC/P 2
The enhanced version of the ESC/P printer command language. Commands in 
this language produce laser-like features, such as scalable fonts and enhanced 
graphics printing.

Finest detail
This printer software setting automatically makes your printouts sharper and 
clearer, especially for text. Be aware that this may increase the time required for 
printing.
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Flip Horizontal
This printer software setting automatically flips your printout, left to right. 

font
A style of type designated by a family name.

grayscale
A scale of shades of gray from black to white. Grayscale is used to represent colors 
when printing with black ink only.

halftones
Patterns of black or colored dots used to reproduce an image.

high speed printing
Printing in which the print head prints images in both directions as it moves back 
and forth. This provides faster printing.

ICM (Image Color Matching)
The color matching method used by Windows 98, 95, and 2000 to match the colors 
in your printout with the colors displayed on your screen.

initialization
Returns the printer to its defaults (fixed set of conditions). This happens every 
time you turn on the printer or reset the printer.

ink cartridge
Contains the ink that your printer uses to print.

ink jet
A method of printing in which each letter or symbol is formed by precisely 
spraying ink onto paper.

interface
The connection between the computer and the printer. A parallel interface 
transmits data one character or code at a time. A serial interface transmits data 
one bit at a time. 

interface cable
The cable that connects the computer to the printer.

local printer
The printer connected to the computer’s port directly by an interface cable.

media
Materials upon which data is printed, such as envelopes, plain paper, special 
paper, and transparency film.

memory
The part of the printer’s electronic system that is used to store information (data). 
Some information is fixed and is used to control how the printer operates. 
Information that is sent to the printer from the computer is stored in memory 
temporarily. See also RAM and ROM.
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MicroWeave
Printing in which images are printed in finer increments to reduce the possibility 
of banding and to produce laser-like images. See also banding.

monochrome
Printing which uses only one color of ink, usually black.

nozzles
Fine tubes in the print head through which ink is sprayed onto the page. Print 
quality may decline if the print head nozzles are clogged.

operation check
A method for checking the operation of the printer. When you perform a printer 
operation check, the printer prints the ROM version, code page, ink counter code, 
and a nozzle check pattern.

parallel interface
See interface.

port
An interface channel through which data is transmitted between devices.

printable area
The area of a page on which the printer can print. It is smaller than the physical 
size of the page due to margins.

printer driver
See driver.

printer software
The printer software which comes with your printer includes a printer driver and 
printer utilities. The printer driver lets you choose from a wide variety of settings 
to get the best results from your printer. The printer utilities help you check the 
printer and keep it in top operating condition. See also driver and utilities.

printer utilities
See utilities.

print queue
When your printer is connected to a network, a waiting line in which print jobs 
that are sent to the printer while it is busy are stored until they can be printed.

RAM
Random Access Memory. The portion of the printer’s memory used as a buffer 
and for storing user-defined characters. All data stored in RAM is lost when the 
printer is turned off.

reset
To return a printer to its defaults by turning the printer off and then back on.

resolution
The number of dots per inch used to represent an image.
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ROM
Read Only Memory. A portion of memory that can only be read and cannot be 
used for data storage. ROM retains its contents when you turn off the printer.

RGB
Red, green, and blue. These colors, in phosphors irradiated by a cathode ray tube 
(CRT) monitor’s electron gun, are used to create the additive array of screen 
colors.

serial interface
See interface.

Smooth Edge
Improves the print quality of lower-solution images by smoothing jagged edges 
and lines. This setting has no effect on high-resolution images or on text.

spool
The first step in printing, in which the printer software converts the print data 
into codes that your printer understands. This data is then sent directly to the 
printer or to the print server.

spool manager
The software that converts print data into codes that your printer understands. 
See also spool.

sRGB
The color management method used to maintain color consistency between 
devices which adhere to the sRGB standard.

Status Monitor
The software that allows you to check the printer’s status.

subtractive colors
Colors produced by pigments that absorb some colors of light and reflect others. 
See also CMYK.

USB interface
Universal Serial Bus interface. Enables the user to connect up to 127 peripheral 
devices (such as keyboards, mice, and printers) to the computer through a single, 
general-purpose port. The use of USB hubs allows you to add additional ports. 
See also interface.

utilities
Software that allows you to monitor and maintain your printer. Together, utilities 
and the printer driver are referred to as "printer software". See also printer 
software.

WYSIWYG
What-you-see-is-what-you-get. This term is used to describe printout that looks 
exactly like it appears on screen.
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Adjust lever 2, 1-4
Advanced settings

Macintosh 5-11
Windows 3-12

Automatic setting
Macintosh 5-8
Windows 3-9

B

Background printing 5-15, 6-4–6-7
Buttons 2

C

Cleaning
print head 9-3–9-8
printer 9-9

Cleaning sheets 1-2
ColorSync setting (Macintosh) 5-10
Configuration settings 6-3
Consumables 11-1
Control panel 2, 3

Cleaning the Print head 9-2
Nozzle checking 9-2
Replacing ink cartridges 8-1

Custom paper size
Macintosh 5-23
Windows 3-20

Custom settings
Macintosh 5-10
Windows 3-11

Custom Settings dialog box
Macintosh 5-13
Windows 3-14

Customer support 10-33

D

DMA transfer 3-51
Double-Sided Printing

Macintosh 5-26

E

Economy setting
Macintosh 5-10
Windows 3-12

Edge guides 1
Envelopes 1-6–1-7, A-6
EPSON Monitor 3 6-4–6-7
EPSON Spool Manager 4-3
EPSON Status Monitor 3 

(Windows) 4-4–4-5
EPSON StatusMonitor 

(Macintosh) 6-1
Error notification

Macintosh 6-2
Windows 3-47

F

Fit to Page
Macintosh 5-32
Windows 3-25
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Glossy film 1-5, 11-2
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Head Cleaning 9-2, 9-4

I

ICM setting 3-12
Ink cartridge clamps 2
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Ink cartridge Replacement button 2
Ink cartridges

Replacing 8-1, 8-7
Specifications A-8–A-9

Ink jet card 1-5, 11-2
Ink jet paper 1-5, 11-2
Ink setting

Macintosh 5-14
Windows 3-15

Iron-on cool peel transfer paper
1-5, 11-2

L

Layout dialog box 
(Macintosh) 5-32–5-35

Layout menu (Windows) 3-25–3-35
Lights 3, 10-3–10-4
Loading paper 1-1

M

Matte Paper-Heavyweight 1-6, 11-2
Media 1-2, 11-2
Media Type setting

Macintosh 5-3
Windows 3-4

Monitoring printing 3-47
Multi-page printing

Macintosh 5-36, 5-37
Windows 3-33, 3-34

N

Network printing
Macintosh 7-9–7-12
Windows 2000 and NT 4.0 7-5–7-9
Windows 95, 98 7-1–7-3

Nozzle checking 9-1–9-3

O

Online help 3-48, 5-43
Orientation settings

Macintosh 5-19

Windows 3-20
Output tray 1
Output tray extention 1

P

Page Setup dialog box 5-19
Paper 1-1, 1-2, 1-6, 11-2

Specifications A-1
Paper jam 10-17
Paper menu (Windows) 3-20–3-23
Paper support 1
Paper support extention 1
Parallel interface cable connector 1
Photo paper 1-5, 11-2
Photo quality glossy film 1-2, 11-2
Photo quality glossy paper 1-2, 11-2
Photo stickers 1-5, 11-2
PhotoEnhance settings

Macintosh 5-9
Windows 3-10

Premium Glossy Photo Paper 1-2, 11-2
Preview feature
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Windows 3-16

Print head 2
alignment 9-8–9-9
cleaning 9-3–9-8, 9-9–9-10
nozzle checking 9-1–9-3

Print Head Alignment Utility 9-8–9-9
Print Quality setting

Macintosh 5-12
Windows 3-13

Print speed, increasing 3-49–3-55
Print time setting 5-14
Printable area setting

Macintosh 5-19
Windows 3-20

Printable area specifications A-6
Printer

cleaning 9-9
Specifications A-10
transporting 9-10

Printer cover 1
Printer parts 1
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Printer Software for Macintosh 6-1
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utilities 5-41–5-42

Printer Software for Windows
accessing 3-2–3-55
changing settings 3-15
utilities 3-41–3-48

Printing tips 4-1

R

Reduce/Enlarge setting
Macintosh 5-22
Windows 3-25
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S

Safety information 4, 8
Saving settings

Macintosh 5-13
Windows 3-14

Self adhesive sheets 1-5, 11-2
Sheet feeder 1
Special paper 1-1
Specifications
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mechanical A-10
paper A-1–A-6
printing A-1
safety approvals A-12

Speed & Progress settings 3-51
Spool Manager 4-3
sRGB setting 3-12
Status Monitor

Macintosh 6-1
Windows 4-4–4-5

System Requirements A-12, A-13

T

Transparencies 1-5, 11-2
Troubleshooting 10-1–10-18

U

Updating the driver 9-13
USB interface cable connector 1
Utilities

Macintosh 5-41–5-42
Windows 3-41–3-48

W

Watermark setting
Macintosh 5-33
Windows 3-38
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